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Disclaimers/Warnings 
 
SUITABILITY FOR USE — THIS PRODUCT IS NOT DESIGNED, 
AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE IN 
APPLICATIONS WHERE ITS FAILURE OR MALFUNCTION CAN 
REASONABLY BE EXPECTED TO RESULT IN PERSONAL INJURY, 
DEATH OR SEVERE PROPERTY OR ENVIRONMENTAL DAMAGE.  
DYCOR ACCEPTS NO LIABILITY FOR INCLUSION IN SUCH EQUIPMENT 
OR APPLICATIONS AND THEREFORE SUCH INCLUSION AND/OR USE IS 
AT THE CUSTOMER’S OWN RISK. 

DO NOT USE THE SMARTVUE TO DIRECTLY CONTROL EQUIPMENT 
SUCH AS MOTORS, VALVES OR ACTUATORS NOT PROPERLY 
EQUIPPED WITH SAFEGUARDS. 

FOR SAFTEY PURPOSES, THE EARTH GROUND TERMINAL IS 
ELECTRICALLY CONNECTED TO THE EXPOSED CONDUCTIVE PARTS 
OF THE SMARTVUE.  THE EARTH GROUND CONNECTION MUST BE 
CONNECTED TO AN EXTERNAL EARTH GROUNDING SYSTEM. 
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Statement of Limited Warranty 
 
Dycor warrants the goods sold hereunder, under normal use and service as described in the 
operator's manual, will be free from defects in materials and workmanship for a period of twelve 
(12) months from the date of delivery to the original purchaser. Any product that is found to be 
defective within the warranty period will, at the option of Dycor, be repaired or replaced.  
This limited warranty does not cover losses or damages that occur in shipment to or from Buyer 
or due to improper installation, maintenance, misuse, neglect or any cause other than ordinary 
commercial or industrial application.  This limited warranty is in lieu of all other warranties 
whether oral or written, expressed or implied.  Dycor’s liability shall not exceed the price of the 
individual unit which is the basis of the claim.  In no event shall Dycor be liable for any loss of 
profits, loss of use of facilities or equipment or other indirect, incidental, or consequential 
damages. 

Trademarks 
 
Products named in this document may include copyrights, trademarks, or registered trademarks 
and are acknowledged as the property of their respective companies.   

FCC Notification 
 
This device complies with part 15 of the FCC rules.  Operation is subject to the following two 
conditions: 1) This device may not cause harmful interference and 2) this device must accept any 
interference received, including interference that may cause undesired operation.   

About This Manual 
 
This manual covers the use of the SmartVue Process Control Monitor and is subject to change as 
the product is developed.  It describes: 
 

 How to use the graphic user interface 
 How to connect power and inputs/outputs to/from the SmartVue 
 How to configure the SmartVue and display data 
 How to panel mount the SmartVue
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1.0 Introduction 
This manual describes the operation of the SmartVue™ Process Control Monitor and 
covers the use of the embedded firmware through to version 2.60.  The appendix 
describes the panel mounting installation for the SmartVue and summarizes the terminal 
connections. 

The SmartVue displays the values for selected input signals according to user definable 
scales.  Up to four separate meters can be displayed simultaneously on its 3.5-inch LCD 
screen.  It is easily configured using an intuitive graphical interface that is navigated 
using its touch screen.  Settings may be permanently stored in the device’s memory, and 
it will start up with its last saved configuration. 

The SmartVue’s compact size, easy-to-use interface and versatility make it an effective 
tool for control and monitoring in a variety of industrial applications. 

The SmartVue operates around the concept of a user defined process that receives an 
input in the form of an externally connected electrical signal and optionally generates an 
output signal according to a set configuration.  The input signals can be scaled and 
displayed on the Meter screen with meaningful units.  Likewise, the output signal can 
also be scaled to conform to the requirements of an externally connected device. 
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2.0 Getting Started 

2.1 Connecting Power 
To power up the SmartVue so you can begin configuring it, an external power supply is 
needed.  The SmartVue requires a 10 to 30 VDC, externally fused power source, 
connected to J4-1 (positive) and J4-2 (ground).  To protect the unit from potential 
electrostatic discharge, J4-3 (EARTH) should be connected to the metal surface of the 
mounting enclosure. 

 

  
1

  
 2

  
 3

  
4

  
 5

  
 6

 

 

Figure 2-1   External power connection 

The power connections are also listed in Table 21-1. 
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2.2 Starting up the SmartVue 
When the SmartVue is powered on you will briefly see a splash screen (Figure 2-2) 
displaying the boot loader version number, serial number, model number, manufacture 
date, and MAC address of the unit along with some other startup messages. 

     
Figure 2-2   Splash screen 

Special startup options 
You can override the SmartVue’s normal startup if you press and hold on the 
touch screen while the unit is powered on.  This will display the Boot Menu 
described in Section 19.0.  The Boot Menu displays options for running memory 
diagnostics, configuring the LCD brightness, calibrating the touch screen and 
updating the firmware version. 

 

Once the unit’s self-test is completed the Meter screen will be displayed.  A few 
examples of the Meter screen are shown in the figure below. 

     
Figure 2-3   The Meter screen 

The Meter screen displays up to four meters so that the input data you provide to the 
SmartVue can be easily read.  Depending on the type of process you have assigned to a 
meter and various meter configuration options, you may also see buttons or threshold 
indicators on a given meter.  Indicators can also display the status of digital I/O points. 

Pressing the MENU button will take you to the Main menu screen. 
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2.3 The Touch Screen Interface 
The LCD display is overlaid with a touch screen which provides the means for user 
interaction with the software.  Button activation, text, and numerical entry are all 
achieved by touching, or pressing, the related graphic representation.  When a textbox 
designed for character entry is pressed, a keyboard will be displayed (Figure 2-4).  
Likewise, when a textbox meant for numerical entry is pressed, a numerical keypad 
(either decimal or hexadecimal) is displayed (Figure 2-5). 

     
 

     
Figure 2-4   The various keyboards for text/symbol entry 

     
Figure 2-5   Decimal and hexadecimal keypads 
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Table 2-1   Special keyboard keys 

 Backspace 

 Toggle between upper and lower case 

 Displays a combined numeric and symbol keyboard 

 Display a symbols only keyboard 

 Enter the value into the selected text/numeric field 

 



SmartVue Operator’s Manual 

6  10-0004-R13 

2.4 The Main Menu 
Pressing the MENU button on the Meter screen will display the Main Menu shown in 
Figure 2-6.  From here you can navigate the SmartVue’s various menus and configuration 
screens.  A block diagram showing the menu hierarchy is shown in Figure 2-7.  A 
summary of the Main Menu items is listed in Table 2-2. 

 
Figure 2-6  The Main Menu screen 

Table 2-2  The Main Menu 

Main Menu Button  Description  
Configure I/O Allows configuration of the default settings for all of the SmartVue’s 

inputs and which multipurpose I/O points will be used for outputs.  It 
also provides access to the 4-20mA calibration and logic threshold 
settings. 

Set Outputs Provides options for assigning one for more of the SmartVue’s 
outputs to a process and setting output scaling factors. 

Processes Displays a menu of currently assigned and/or disabled processes 
that you can configure to use a SmartVue input. 

Communications Displays a menu that allows various communications protocols to be 
configured including Ethernet and J1939-11. 

Control Processes Displays a menu of currently assigned and/or disabled control 
processes that you can configure to use a SmartVue input. 

SmartVue Provides access to the password protection system, display 
configuration, data monitoring, and the firmware uploading feature. 

Meters Allows you to assign a process to a meter for display on the Meter 
Screen.  It also allows configuration for data averaging, and meter 
limit indicators.  

File System Displays a menu of file system operations allowing you to save your 
current configuration changes or load a preconfigured set of 
processes, meters, and I/O configuration settings.  Note: if you load 
the default settings and then press Save Settings your own settings 
will be overwritten with the built-in defaults. 

Run / Stop Provides options for controlling the SmartVue’s operational modes 
for processes and outputs. 
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Note, you may experience a slight delay when exiting the Main menu to return to the 
Meter screen when one or more history graphs is being displayed since the buffered 
history data must be read to render the graphs. 

A small lock icon is displayed next to each block for a screen that can be locked, and thus 
made inaccessible when password protection in turned on.  Refer to Section 14.0 
Password Protection for more information. 
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Figure 2-7   Block diagram of the SmartVue’s menus and screens 
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2.5 Special Icons 
One or more icons may be displayed in the upper right-hand corner of the screen for 
several conditions.  They are summarized in the table below. 

Icon Description 

 There are unsaved configuration changes 

 A remote connection has been established 

 
A remote connection has been established and local touch 
screen control has been disabled 

 The main password has been set and the user is logged in 

 
The main password has been set and the user is logged out 
preventing access to certain configuration screens 

 
One or more active DTCs has been detected on the J1939 
bus 

 

A process configuration change has affected one or more 
associated outputs disabling it – it must be reviewed and 
manually re-enabled 

 Data logging is enabled 

 Data logging is paused 

 The data logging memory is full 

 The data logging memory is full and paused 
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3.0 I/O Configuration 
The I/O configuration feature of the SmartVue allows you to specify default settings for 
the inputs and outputs and how certain I/O points will function.  For example, the 
multipurpose I/O points can each be independently configured to work as an analog 
input, a digital input, or a digital output. 

If you have an I/O setup that you will use on a regular basis, you may wish to configure 
the SmartVue’s I/O points with that setup in mind so that it is available as the default.  
When setting up a process, you have the option of using the Load Defaults from IOConfig 
button to load default values setup in the Configure I/O options described below. 

 
Figure 3-1  The Configure I/O menu 

Remember to save your settings! 
If the power is shut off to the SmartVue, any changes you make to the  
configuration will be lost unless you save your settings first.  A small 
diskette icon will appear in the upper right of the screen to remind you 
that you have unsaved changes.  On the Main menu press File System 
and then Save Settings. 

3.1 Current Loop I/O 
The SmartVue’s two current loop inputs and two current loop outputs can be set with a 
default configuration.  The Current Loop I/O configuration menu, shown below displays 
a menu for each current loop I/O point. 

 
Figure 3-2  The Current Loop I/O configuration menu 
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Figure 3-3  Configuration screens for Current Loop I/O 

The current loop I/O configuration settings are summarized as follows: 

Label  The identifying label that will appear on the meter screen. 

Units  The engineering units the value will be displayed with. 

scale values The minimum and maximum expected current values and 
corresponding engineering values for determining scaling.  For a 
current loop input the values on the left represent the expected 
range of current values that the SmartVue may receive from a 
sensor or some other device.  For an output, the values on the right 
represent the expected range of currents that the unit will provide 
to an external device.  In either case, current values may exceed the 
given range since the values are merely used to calculate 
corresponding scaled values. 

Example: Connect a loop powered transmitter using t he SmartVue as the 
power source. 

In this example a current loop device connected to 4-20mA IN 1, requiring loop power, 
receives it from the SmartVue’s built-in supply. 

 

Figure 3-4  J1 wiring to use loop powered transmitter with power from the SmartVue 
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3.2 Multipurpose I/O (Digital I/O and Voltage Input s) 
The SmartVue is equipped with six channels that can each independently function as a 
digital input, digital output or analog voltage input designed for an input range of 0 to 10 
volts.  When you navigate to the Multipurpose I/O configuration menu (shown below) the 
buttons indicate the currently configured I/O type for each channel in parentheses.  An 
assortment of I/O types is preset on the SmartVue. 

 
Figure 3-5  The Multipurpose I/O configuration menu 
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 To configure a Multipurpose I/O channel 

1. Press MENU > Configure I/O > Multipurpose I/O . 

2. Press the button for the channel (DIO/VIN 1 to 6) that you wish to configure. 

3. Choose the desired I/O type: Digital Input , Digital Output  or Voltage Input. 

4. Configure the I/O channel: 

Digital Input/Output 

Label  The identifying label that will appear on the meter screen. 

Low State  The characters that will be displayed on the meter screen for a 
low digital input signal. 

High State  Digital Input:  The characters that will be displayed on the 
meter screen for a high digital input signal. 

HiZ State  Digital Output:  The characters that will be displayed on the 
meter screen when the output is in a high impedance state. 

Pull-up  Turns the pull-up resistor on or off for the given digital input or 
output. 

Voltage Input 

Label  The identifying label that will appear on the meter screen. 

Units  The engineering units that the input voltage will be scaled to 
represent. 

scale values The minimum and maximum input voltages and corresponding 
engineering values. 

5. Press OK . 
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3.3 Total/Rate Counters 
The SmartVue is equipped with three Total/Rate Counters whose inputs can also double 
as possible quadrature input counters.  Two tachometer inputs are also available.  As the 
name indicates, there are two quantitative elements: total and rate, either of which may be 
chosen for display on the Meter screen with their own distinct label and unit settings.  
You could also choose to display the total on one meter and the rate on another. 

The Total/Rate Counters configuration menu is shown in Figure 3-6. 

 
Figure 3-6  The Total/Rate Counters configuration menu 

The Total/Rate Counters configuration settings are summarized as follows: 

K Factor  A scaling value by which the count value is divided to convert the 
input pulses to engineering units. 

Label  The identifying label that will appear on the meter screen. 

Units  The engineering units the value will be displayed with. 

Time Base  Use to set the period over which counting will take place. 

Pull-up  If needed, pull-up resisters can be enabled for the counters, the 
tachometers do not require them. 

Mode  (Counter 3 only) Counter 3 can be configured to operate as a 
regular counter or as a quadrature counter.  The possible modes are 
Counter, Quad x2 and Quad x4. 
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3.4 Temperature 
Default configuration settings for the RTD temperature sensor input are set using the 
Configure I/O - Temperature screen shown below.  These defaults merely represent the 
values that will be used when a new temperature process is created so that a process can 
be set up more quickly.  This assumes, of course, that the default settings are ones that 
you use most often.  In the case of a temperature process, the Label and Unit settings can 
be conveniently loaded from the defaults when you later set up a process that uses them. 

 
Figure 3-7  The Configure I/O - Temperature screen 

The temperature configuration settings are summarized as follows: 

Label  The identifying label that will appear on the meter screen. 

Units  The temperature scale and units the value will be displayed with: 
°C, °F, K for Kelvin. 

Resistance  This should correspond to the resistance specification of the RTD 
being used.  The SmartVue supports 100- and 500-ohm sensors. 

Scale  This is the thermodynamic temperature scale applied as the 
standard by which measured values from the sensor will be 
converted to a practical temperature scale like °C or °F.  The more 
modern ITS-90 scale is more accurate, but the simpler IPTS-68 is 
still used for some industrial applications since it still gives 
acceptable accuracy. 
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3.5 Voltage Outputs 
Settings for the two voltage outputs (0-10V OUT 1 and 2) may be made to provide 
between 0 and 10 volts based on a scale you provide for a device you wish to control.  In 
the example below, a 0.00 bar pressure is equal to a 1.00-volt output on 0-10V OUT 1 
while 20.00 bar equates to an output of 10 volts. 

 
Figure 3-8  The Configure I/O - 0-10V OUT 1 screen. 

3.6 Frequency Outputs 
Like the voltage outputs, the frequency outputs can be configured with desired labels, 
units and scales to work in conjunction with a process that provides a square wave output 
to a device.  The screen below shows a possible setup. 

 
Figure 3-9  The Configure I/O - FREQ OUT 1 screen 
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3.7 4-20mA Calibration 
To ensure the precise accuracy of the current loop input measurements, the 4-20 mA 
current loop input channels can be independently calibrated.  With a known 4 mA source 
supplied to a current loop input, the raw, unconverted value supplied by the analog-to-
digital convertor can be read and set as the corresponding reference for that current level.  
Finally, the raw value read when a 20 mA source is supplied to the same input will 
calibrate the current loop input channel range characteristic. 

 To calibrate a 4-20 mA Current Loop Input 

1. Press MENU > Configure I/O > 4-20mA Calibration to display the following 
screen. 

 

2. Connect a power supply that delivers 4 mA of current to the 4-20mA current input 
you wish to calibrate (4-20mA IN 1 or 2) and then press the Calibrate 4mA 
button to set the measured raw current value as the calibrated reference for 4 mA. 

3. Likewise, set the supply to deliver 20 mA and then press the Calibrate 20mA 
button to set the raw value as the calibrated reference for 20 mA. 

4. Press OK . 

3.8 Logic Thresholds 
The logic thresholds define the voltage levels at which a low state will transition to a high 
state and vice versa.  A threshold level for the six DIO/VIN points on the J2 terminal 
block can be configured.  Likewise, the quadrature/counter inputs together with the two 
frequency outputs (indicated by QENC and FRQ OUT on the terminal block legend) can 
also be configured with a particular threshold level. 

 To adjust the logic thresholds 

1. Press MENU > Configure I/O > Logic Thresholds. 

2. Enter a value for the DIO/VIN  logic threshold between 0 and 15 volts. 

3. Enter a value for the QENC/FRQ logic threshold between 0 and 15 volts. 

4. Press OK . 
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4.0 Setting Up a Process 
For the SmartVue, a process is simply defined as the continuous acquisition of a 
measurable signal or user supplied value (an input) that can be displayed in a meaningful 
way with quantifiable units.  The input value may in turn be used to control one or more 
outputs.  A process can also be assigned to a meter (or even multiple meters) so it can be 
displayed on the Meter Screen. 

Keep in mind that the SmartVue makes a distinction between two types of processes: 
(basic) processes and control processes.  A control process incorporates feedback for 
closed-loop control.  In this section we will discuss the basic process that does not 
incorporate feedback. 

The block diagram below shows the SmartVue’s functional components for a basic 
process.  The dashed blocks indicate an optional setup for a process. 

 

Figure 4-1   A basic process 

The SmartVue allows up to eight processes and two control processes to be configured.  
The types of processes that can be configured are summarized in Table 4-1. 

Table 4-1   SmartVue Process Types 

Process Type Input Modes 

Total/Rate 

Counter 1 Counter or Quad x2, x4; Pull-up: On/Off 

Counter 2 
Pull-up: On/Off; Used as QEnc-B input when 
Counter 1 is set to Quad mode 

Counter 3/QEnc 1 Counter or Quad x2, x4; Pull-up: On/Off 

Tach IN 1..2  

Current Loop Input 4-20mA IN 1..2  

Temperature n/a 100 Ω or 500 Ω RTD (3-wire) 

Multipurpose I/O DIO/VIN 1..6 
Any combination of digital inputs, digital 
outputs, or analog voltage inputs (0-25 V) 

J1939 SPN Active SPN  

Modbus Modbus User Register  

Process Control 
Control 1 PID, PID with external setpoint 

Control 2 PID, PID with external setpoint 

 

• Label 
• Units 
• Scale 

Input 

 
Meter 

 
Scale Output 
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 To create a new process or edit and existing process 

1. Select MENU > Processes.  This will display the menu of processes that are 
currently assigned or disabled.  Any existing process can be edited if it is not 
locked.  Press a button corresponding to a process you wish to create.  Use the 
arrow buttons to configure up to eight processes. 

 

2. Choose a Name, Type, and Input point for the process. 

• Name – Enter a name for your process to uniquely identify it (up to 20 
characters). 

 

• Type – Select a process type suitable for the sensor that you have connected 
to the SmartVue (Total/Rate, Current Loop Input, Temperature (RTD), 
Multipurpose I/O (digital or voltage input), J1939 SPN or Modbus). 

• Input  – Select an input point/channel that will supply the measured value. 

• Label, units, other settings – Enter a label and engineering units that will 
appear on the Meter Screen.  To quickly load previously defined values are 
not what you want to use, press the Load Settings from IOConfig. 

3. Press the left or right arrow button to advance to the next configuration screen for 
the process.  Note: the selected input type will determine the kind of configuration 
screen that will be displayed. 

4. Other parameters: 

• Scale (analog inputs) – Minimum and maximum scaling factors are used so 
that the measured signal values can be converted to real-world engineering 
values. 

• K Factor (counters) – A scaling value by which the count value is divided to 
convert the input pulses to engineering units. 

Press either the right or the left arrow 
button to advance to the next configuration 
screen.  The type of configuration screen 
that is displayed will depend on the input 
type you select. 
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• Time base (counters) – Use to set the period over which counting will take 
place. 

• Low/High states (digital inputs) – Short text messages displayed on the 
meter depending on the high or low state of the selected digital input. 

• Timeout (Modbus) – A feature of Modbus inputs is to change their value if 
data updates have not occurred within a certain time.  There is also a setting 
for the value to use at power up before any data is written to the register. 
 

 
 
There are 4 timeout actions: 

1. Set to fixed value: After the timeout, the process (or control process) 
will use the specified fixed value. 

2. Fixed + error: Same as above but also the process (or control process) 
will have its internal error flag set.  A meter configured for this process 
will display TIMEOUT. 

3. Keep last value: After the timeout, the process (or control process) 
will continue to use the value in the register. 

4. Keep last + error: Same as above but also the process (or control 
process) will have its internal error flag set.  A meter configured for 
this process will display TIMEOUT. 

During the power up stage (before the first value is written to the register) 
the process or control process will have its internal error flag set and, if 
configured for a meter, it will display “NO DATA”. 
 

5. Press OK . 
 

When a process is created its name appears on its corresponding button on the Processes 
menu screen.  If a button displays the word “Disabled” then it will not acquire a signal 
from its respective input and any meters assigned to it will not be displayed on the Meter 
screen. 
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The red exclamation point 
By now you may have discovered that when you change one part of a  
process, it can influence another.  In that case, you may see a 
red exclamation point in the upper right corner of the screen or on 
certain buttons indicating that some configuration settings may no longer 
be valid, or a change may have affected (and possibly disabled) an 
output.  If this happens confirm that your configuration is correct by verifying or 
changing the affected settings. 

 

Example: Set up a Temperature Process Using an RTD (Resistance 
Temperature Detector) 

1. Connect a 100-ohm or 500-ohm RTD (3-wire) to the J2 terminal connector as 
shown in Figure 4-2.  The temperature sensor may of course be connected to the 
end of a long cable so that it can be placed in a location where you wish to make 
an accurate temperature measurement. 

 

Figure 4-2   J2 wiring for an RTD. 

2. Select MENU > Processes to display the Processes menu. 

3. Press the button for an unused process (or a process you don’t mind 
reconfiguring). 

4. Enter a name for the Process (e.g., “Temperature”), then select Temperature 
using the Type spinner button.  Your screen should now look like the one below.  
(In this case password protection is shut off so no Lock button is displayed.) 
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5. Press an arrow button to advance to the next setup screen.  This will display a 
screen like the one below.  Defaults, which you may define yourself, can be 
loaded from the I/O Configuration options by pressing the Load Settings from 
IOConfig  button.  (Refer to Section 3.0 I/O Configuration for setting up default 
I/O configurations.) 

     

6. Press OK . 

7. While you could look at the Monitor Data screen to observe your temperature 
measurements right away, you will likely want to display this information on the 
Meter Screen.  The example in Section 6.0, Assigning and Configuring a Meter, 
will show you how to do just that. 

 
Notes 

• The RTD value displayed on the Monitor Data screen will be with the units 
configured using the Configure I/O, Temperature screen and is not affected by the 
process configuration. 

• If a fault occurs with the RTD sensor (such as a disconnection), any enabled 
output that is tied to the associated process will be disabled if the output is set to 
auto disable.  The output must be manually re-enabled after the fault has been 
corrected. 
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5.0 Setting Up a Control Process 
Like a process, a control process incorporates the continuous acquisition of a measurable 
signal.  In this case, however, an output value (called the modified variable) is required so 
that changes to the process being controlled can be measured via a feedback sensor and 
an error value (the difference between the user specified setpoint and the measured input 
value being fed back) can be computed.  The result is subsequently supplied to a PID 
control algorithm so that the error value can be minimized over time.  The block diagram 
below shows how the various aspects of a control process work together. 

 

Figure 5-1   Block diagram of a closed-loop control process 

In addition to the modified variable, various other parameters for a control process can be 
assigned to a meter so it can be displayed on the Meter screen including: the feedback 
variable, the error value, and the setpoint value.  The control process input value can, of 
course, also be chosen for display. 

You also have the choice of using either a manually entered setpoint or an external 
setpoint that is governed by the signal connected to one of the SmartVue’s inputs. 

Setting up a control process is similar to setting up the basic process explained earlier.  
The instructions below describe the procedure for setting up the control process while the 
output setup is described in Section 7.0 Setting Up an Output. 

• Label 
• Units 
• Scale 
• Setpoint (manual) 
• PID parameters 

Sensor Input 

 
Meter 

 
Scale 

Output 

 
Sensor 

Feedback 

Process 
being 

controlled 

SmartVue 

Modified 
Variable  

External Setpoint 
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 To create a new, or edit an existing Control Process 

1. Select MENU > Control Processes.  This will display the menu of control 
processes that are currently assigned or disabled.  Any existing control process 
can be edited if it is not locked.  Press a button corresponding to a control process 
you wish to create or edit. 

 

2. Define the control process 

• Name – Enter a name for your process (up to 20 characters), then select a 
process type and an input point that will supply the measured value. 

• Mode – Choose the control mode. 

 PID – Closed loop PID control with a manually entered setpoint value. 
 PID Ext SP – Closed loop PID control that uses another input as the 

setpoint. 
 PID Ext SP w/MULT  – Closed loop PID control that uses another input 

as the setpoint and an entered value to multiply the setpoint input. 
 Disabled – The Control Process and its associated output are disabled.* 

     

• Type – Select the type of input that will serve as the sensor feedback signal. 

• Input  – Select the input channel for the specified feedback type. 

• SP Type – (Displayed only if the Mode is PID Ext SP.)  Select the type of 
input that will serve as the setpoint signal. 

• SP Input – (Displayed only if the Mode is PID Ext SP.)  Select the input 
channel for the specified setpoint type. 

 
* The output is set to its prescribed non-active state: voltages and frequencies are set to zero, current outputs are set to 3.8 mA, and digital outputs 
will be high. 
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3. Press the right arrow button to proceed to the feedback input scale configuration. 

4. Feedback label, units, scale – If you have pre-configured IO units and scales 
values that you want to use for the selected input type, press the Load Settings 
from IOConfig  button to load them.  Enter a label and engineering units that will 
appear on the Meter Screen then enter scaling values for the input signal so that 
the displayed values accurately reflect the value being measured for the 
engineering units you have chosen. 

 

Note that input scaling values will not be applied to the control process 
computation algorithm until either Apply  (see below) or OK  are pressed. 

5. If the control mode is PID Ext SP, the next screen will be the setpoint scale 
configuration which is configured as described in the previous step.  Proceed to 
the next screen. 

6. PID Parameters: Enter values for the Setpoint (PID mode only), the PID 
coefficients, Kp , Ki , and Kd , as well as Imax, Imin , and the Sample Interval. 

 

Kp, Ki, and Kd are the PID algorithm coefficients or gains.  Imax and Imin set 
limits for the I term, preventing it from becoming too large and are specified in 
engineering units for the process output.  The values you choose depend on the 
capability of the system being controlled. 

The valid range for the Sample Interval is 20 to 10000 milliseconds.  A slower 
system that is less sensitive to random disturbances or parameter variations does 
not need to be sampled as often.  If using a Modbus register as the Feedback then 
it is suggested to have the sample interval higher than the register update rate. 

You can observe the effects of adjusting the PID parameters on the Feedback, 
Error, and Modified values on this screen and thus tune the control process by 
using the Apply  button. 

Adjust the PID parameters and click Apply  
or OK to update the control process.  You 
can tune your control process by using the 
Apply button and observing the effects on 
the Feedback, Error, and Modified values. 
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7. Press OK . 

8. Setup an output using the procedure outlined in Section 7.0. 

 

Notes 

• Data for the RTD temperature inputs is acquired every 1500 ms while data for the 
Total/Rate inputs is acquired every 100 ms. 

• The setpoint units will be display in red on the PID Parameters screen if they do 
not match the feedback units.  The closed-loop error value is computed by 
determining the difference between these two values. 

• When you assign a control process’s modified variable to a Modbus 
process/control register then the control will be allowed to run since an output has 
been specified. 
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6.0 Assigning and Configuring a Meter 
The meter screen displays data for up to four meters simultaneously with a variety of 
layout options.  Note that while you may usually want to display data for an input on the 
Meter screen, it is not required, and the process will still run. 

                               
 
 

Figure 6-1   Meter screen elements 

Any meter can be configured to display sampled data in one of two forms: a digital meter 
or a history graph.  A digital meter displays data numerically while a history graph 
displays an historical line graph allowing a trend to be observed over a specified period. 

Digital meters can also be configured to control indicators for specified limit values.  
When a limit value is reached you can have it turn on a High or Low indicator on the 
meter and even latch at that state.  These indicators can also act as buttons to configure 
threshold values.  The limit values can also be used to control the state of a digital output.  
If you want to control a digital output based on the value of a certain input, you can set 
the same or different values using the Set Outputs configuration for a digital output.  
Refer to Section 7.0 Setting Up an Output. 

The history graph will display a red vertical line if there is an error reading an incoming 
data value.  This can occur just after the unit has been powered up and the signal 
conditioning firmware is also just starting up.  If the data is outside of the plot range for 
the chosen y-axis scale, then a red line along the horizontal axis will be displayed.  If this 
situation is persistent then you will need to alter your y-axis settings.  These lines will 
appear gray if the chosen data line color is red. 

Note 

• When exiting from the main menu to return to a Meter screen that displays a 
history graph you may notice a delay of several seconds while the stored data for 
the graph is loaded from memory. 

Y-Axis Max.

Y-Axis Min.

Right 
indicator 

Zero button 
(Total/Rate process, Total data point) 

Current 
value and 
units 

Left 
indicator 

Label 

Units 

Current 
time 

History length 

Data read error 

Data out of y–
axis scale range
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 To assign a process to a meter 

1. Select MENU > Meters.  The Meters menu is displayed showing a button for 
every meter position available given the currently selected layout. 

 

2. If you want to show more than one meter on the screen at a time, press the left or 
right arrow button to go to the Meters - Layout screen, and then simply select the 
layout you want.  Press an arrow button again to return to the Meters menu 
screen. 

 

3. Press the button for the meter position you wish to configure.  This will display 
the meter configuration screen.  Depending on the selected meter type you will 
see a slightly different screen. 

     

4. Configure the meter: 

Meter Type – Choose from Digital , History Graph  or Off . 

Process/Control – Selects the enabled process you wish to display. 

Data Point – Selects the type of data you wish to display for the selected 
process (i.e., A Total/Rate process can either display a counter’s total as it 
increments or the rate at which pulses are received.) 
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Zero Button – Allows the option of displaying a Zero button on the meter for 
Total meters and data for analog inputs where the I/O configuration defaults 
for the process have been overridden. 

History Length – (Displayed for the History Graph meter type.) Select the 
length of time to display on the horizontal axis of the meter’s history graph.  
Possible values range from 23 seconds to 24 hours. 

Average – Specifies the time period over which sampled signals will be 
collected for averaging. 

5. Press Exit .  This will return you to the Meters menu. 

6. Press OK  to apply your changes or Cancel to return to the Main menu without 
applying your changes. 

 

 To configure indicators for a Digital meter 

1. Enter the meter’s configuration screen and press an arrow button to navigate to 
either the Left Indicator or Right Indicator configuration depending on which one 
you want to configure.  You can turn on one or both indicators and specify 
thresholds for each.  Some example screens are shown below. 

     

2. Choose the Signal Source, Threshold values (Meter), and indicator labels and 
colors. 

Signal Source – lets you choose the source that will control the indicator’s on/off 
state.  Possibilities include the meter value, a digital input, or a digital output.  
Note, other than the Meter source, only I/O configured as digital inputs or outputs 
that are enabled will be available for selection. 

Threshold – (Signal Source: Meter) Two thresholds allow for hysteresis.  The 
indicator label and color will change when the meter value drops below the first 
threshold value.  It will also change when the meter value rises above the second 
threshold value. 

Label – The label text that is displayed on the indicator/button for the given 
threshold value (meter or digital input) or output state (digital outputs).  Up to 
seven characters are allowed. 

Color – The color of the indicator/button for the given threshold value (meter or 
digital input) or output state (digital outputs). 
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Allow Threshold Configuration from Meter – The setting, Yes or No, sets 
whether the given indicator’s threshold value can be changed from the Meter 
screen by pressing the indicator image.  This can provide a quick way to change 
the threshold or clear a latched condition without having to navigate through the 
menus.  Setting this option to No can prevent unwanted or unintended changes for 
critical applications. 

3. Press Exit .  This will return you to the Meters menu. 

4. Press OK . 

 

 To configure the plot settings for a History Graph meter 

1. Enter the meter’s configuration screen and press an arrow button to navigate to 
the Plot Settings screen. 

 

Color – The line data color (there are nine to choose from) 

Plot Type – Choose from: Thin , Thick , or Fill 

Y-Axis Max, Y-Axis-Min . – Specifies the maximum and minimum values for the 
vertical y-axis.  You should choose values that will allow your data to be plotted 
within the graphing area. 

2. Press Exit .  This will return you to the Meters menu. 

3. Press OK . 



  SmartVue Operator’s Manual 

10-0004-R13  31 

Example: Assign the Temperature process created ear lier to a meter 

The following table lists the error messages that may be displayed on a meter when using 
the RTD temperature sensor. 

Table 6-1   RTD Error Messages 

RTD Error  Description  
CONN Connection to the RTD temperature sensor is faulty.  Check the 

connections. 

START The SmartVue is starting up and data has not yet been received 
from the signal conditioning circuitry. 

OVER The temperature measurement is above the measurement range of 
the sensor. 

UNDER The temperature measurement is below the measurement range of 
the sensor. 

 

1. Select Meters from the Main menu. 

2. Press the button for a meter position where you want the temperature process data 
to be displayed.  (If desired, use an arrow button to change the number of meters 
that can be displayed and then go back to the previous Meters menu.) 

 

3. Use the Process/Control spinner to find the name for the temperature process you 
created earlier. 

4. Choose the period in seconds over which sampling will take place for a running 
average of the meter. 

5. Press Exit , OK , and then Exit  again to return to the Meter screen to see your new 
meter. 
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7.0 Setting Up an Output 
You can enable one or more outputs to be controlled by a Process or a Control Process.  
It is not required that a standard Process be connected to an output, but it is required for a 
Control Process.  Controlling an output with a standard Process is akin to open-loop 
control, that is, there is no feedback. 

Assuming you already have a process configured, follow the steps below to setup an 
output so that its value is varied by the selected process’ input. 

 To setup an output to use with a Process or Control Process. 

1. Select MENU > Set Outputs.  This will display the first page for the various 
outputs that the SmartVue provides.  Pressing an arrow button here will display 
the second page showing the multipurpose I/O points.  Those that have been 
configured as digital outputs can be used. 

     

2. Press the button for the output you wish to use.  This will display its 
corresponding configuration screen.  The configuration screens for analog signals 
are similar in appearance and include numerical controls for setting an output 
scale.  The digital version includes controls for setting on/off thresholds and 
polarity.  Both types are shown below. 
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Notes 

• Auto disable – To prevent a potentially unpredictable output to an externally 
connected device, if the Enabled spinner is set to Yes (auto disable), the output 
will automatically be disabled if the process’ scale or the I/O configuration is 
changed.  If it is simply set to Yes, the output will not be disabled if the process’ 
scale configuration is changed. 

 

7.1 Using the Current Loop Outputs 
The SmartVue’s two 4 - 20 mA current loop outputs are each designed to work in one of 
two modes: active, where the SmartVue provides the loop power or passive, where the 
SmartVue must rely on loop power supplied by an external device.  To use a current loop 
output as an active source it must have external excitation from a supply voltage.  The 
Field Supply is conveniently located on the same connector to provide such a source. 

For example, to use Current Loop Output 1 in active mode, you must hook up your 
current loop device as shown in the Figure 7-1 below.  The passive mode hookup is 
shown in Figure 7-2. 
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Figure 7-1   J1 wiring to use 4-20mA OUT 
1 in active mode 
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Figure 7-2   J1 wiring to use 4-20mA 
OUT 1 in passive mode 

 

Notes 

• The field supply, voltage outputs, and current loop inputs and outputs are isolated 
from all other connections. 
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7.2 Using the Analog Voltage Outputs 
The SmartVue provides two analog voltage outputs that operate in the range of 0 to 10 
volts with an output impedance of 100 ohms, and a maximum current of 10 mA.  The 
grounding reference is the 24V- terminal of the field supply.  Figure 7-3 shows the wiring 
for connecting a voltage device to VOUT 1. 
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Figure 7-3   Voltage device connected to VOUT 1 

7.3 Using the Frequency Outputs 
The two frequency outputs each provide a square wave from 0 to 6,250 Hz.  Figure 7-4 
shows how a device requiring a frequency input would connect to the SmartVue. 
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Figure 7-4   Frequency input device connected to FOUT 1 
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7.4 Using the Digital Outputs 
One or more digital outputs can be controlled by a Process so that its logical state is 
toggled when a specific threshold value is reached.  They can thus be used to turn other 
connected devices or indicators on or off when a certain measured signal condition is 
met.  This function can work in one of three modes, depending on the type of source 
process that is selected: Threshold, Latching, and Switching.  When you want to 
manually control a digital output you can also set it to a fixed value: on or off. 

A digital output can be enabled or disabled to link or unlink it from a process if need be.  
When it is disabled, it will not be controlled by the process it is associated with. 

The digital outputs are open collector to ground.  When a digital output is turned on, the 
open collector circuitry sinks to ground so that whatever device you may have connected 
to it will conduct a current and thus be turned on.  If needed, internal pull-up resistors can 
be enabled to provide a pull-up of +10 to +30 volts through an internal reference diode.  
This is accomplished through the Configure I/O, Multipurpose I/O setup screen. 

7.4.1 Threshold Mode 
Figure 7-5 shows the configuration screens for a digital output for which the state 
depends on an analog input (in this case a current loop input).  With the Mode configured 
as Threshold, when the HiZ threshold is surpassed, the assigned digital output will go 
high.  Likewise, when the low threshold 

     
Figure 7-5   Digital output configuration screens 

In the example figure above, DIO 5 will turn on as the pressure rises above 100 psi and 
turn off as the pressure falls below 10 psi. 

Hysteresis is possible by specifying both a low and a high threshold value.  This is 
helpful when the signal that controls the digital output crosses the threshold frequently 
within a short period of time producing a chattering effect.  An inverted polarity 
characteristic is possible by setting the Low Threshold value larger than the HiZ 
Threshold value. 
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Figure 7-6   Digital output on/off behavior for Threshold mode 

Notes: 

• For Normal polarity, the On-threshold value must be larger than the Off-
threshold.  Likewise, for Inverted polarity the Off-threshold value must be larger 
than the On-Threshold. 

 

7.4.2 Latching Mode 
The Latching mode toggles a digital output when a prescribed threshold value is reached 
but keeps the output in its new state until it is manually reset to its previous state. 

     
Figure 7-7  Set Outputs screens for latching mode with an analog input source 

Two latching conditions are possible: “>=” (greater than or equal to a value), or “<=” 
(less than or equal to a value).  If the latch condition is met, the latch output can be 
configured to toggle low or to the high impedance state (HiZ). 

A latch can be cleared by pressing OK  on the Set Outputs configuration screen shown 
above or on the Meter Indicator configuration screen shown below (if configuration from 
the Meter screen is enabled). 

 Low < HiZ 

“Off” 

“On” 

High Threshold Low Threshold 

“Off” 

“On” 
High Threshold Low Threshold 

Low > HiZ 
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Figure 7-8  Pressing an enabled indicator button on the Meter screen is a convenient way to clear a latch 

condition. 

If the input source is a digital input, the screen will appear slightly differently.  Latching 
can be set to be either HiZ (high impedance) or Low when the digital source is either 
high or low.  

 
Figure 7-9  Set Outputs screen for latching mode with a digital input source. 

Figure 7-9 shows that output DOUT 6 will be latched to HiZ when the digital input signal 
named, “T1” is high. 

7.4.3 Switching Mode 
The Switching mode toggles a digital output depending on the state of the selected digital 
input.  Polarity of the output can be configured to be either Normal or Inverted (Figure 
7-11). 

     
Figure 7-10  Set Outputs screens for switching mode with a digital input source. 
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Figure 7-11  Output behavior for normal and inverted polarities 

7.4.4 Fixed Outputs 
There may be times when you simply want to set an output to a fixed value.  A fixed 
output is one that not associated with a Process and is merely used to generate a desired 
voltage, current, frequency, or digital output value for use as a source or controlling 
signal level for some external device. 

 To set an output to a fixed value 

1. Select MENU > Set Outputs. 

2. Press the button for an output that you wish to set to a fixed value. 

3. Turn on the output by selecting Yes using the Enabled spinner. 

4. Set the Process/Control spinner to Fixed.  You will see a screen like either of the 
ones below depending on the type of output you selected. 

     

5. Enter a fixed value for the output.  For example, if the selected output is 0-10V 
OUT 2 you can enter a value between 0.0 and 10.0 volts. 

6. Press OK . 

Normal polarity 

Low 

High 

Low 

Source 

HiZ 
Output 

Inverted polarity  

Low 

High Source 

Low 

Output 
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Example: Use a fixed voltage output connected to a potentiometer as the 
external setpoint control source to a voltage input  for a control 
process. 

In this example a potentiometer will be used to set the setpoint for a closed-loop PID 
control process along with a 4-20mA-based sensor as the feedback component and a 
multipurpose I/O point configured as a voltage input as the external setpoint. 

1. From the Main Menu, choose Configure I/O > Multipurpose I/O > DIO/VIN 1 , 
and then set the I/O Type to Voltage Input.  Also set an appropriate scale 
default.  You can alter this scale later if you choose to override these defaults.  I/O 
configuration is discussed in more detail in Section 3.0. 

2. Using a sensor that provides 4-20 mA and an appropriately sized potentiometer, 
hookup the J1 and J2 connectors as shown in Figure 7-12. 

 

Figure 7-12   J1 and J2 wiring to use 4-20mA OUT 1 as external setpoint control source. 

3. Follow the instructions in Section 5.0 to create a control process.  You should 
have a control process setup screen like the following.  Note that the input Type, 
and SP Type and SP Input point will vary with your control process setup.  

 

4. Set scales for the feedback element (sensor) and the setpoint input. 
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5. Set appropriate PID parameters and press OK . 

6. From the Main Menu, choose Set Outputs and then 0-10V OUT 1 and configure 
it as a fixed output (refer to Section 7.4) with an appropriate voltage level.  You 
should end up with a screen like the one below, and then press OK . 

 

7. Setup a meter to display the current loop input for the sensor.  You can also setup 
additional meters to display other values for the control process, such as the error 
following the instructions in Section 6.0. 

8. Save your settings if you want to preserve this setup (MENU > File System > 
Save Settings). 
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8.0 Run / Stop Modes 
Four operational modes control how the SmartVue runs.  The Run / Stop menu is shown 
below.  The current mode is indicated with a colored icon and is changed by simply 
pressing the desired mode button. 

 
Figure 8-1  The Run / Stop menu 

Run  is the usual operational mode that the SmartVue uses to run processes and control 
outputs.  The Meter screen will display input values and any outputs tied to a process will 
output signals based on the set configuration. 

Run with Outputs Off  runs processes but outputs that are tied to any processes are set to 
off.  Voltage outputs are set to zero volts, current loop outputs are set to the minimum 
value, digital outputs are set to high impedance, and frequency outputs are set to zero 
hertz.  The Meter screen will display inputs values as with the Run mode. 

Stop Process Control  disables the processes and no further input values are displayed on 
the Meter screen.  Outputs are shut off as with the Run with Outputs Off mode described 
above. 

 
Figure 8-2  The Meter screen when the Stop Process Control mode is engaged. 

Disabled Configuration  disables the processes as with the Stop Process Control mode 
above but places the multipurpose I/O into a floating state to prevent the possibility of 
input signals being inadvertently connected to outputs and vice versa or damage to the 
I/O points or connected devices until the configuration can be validated for the intended 
application. 
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Figure 8-3  The Meter screen when the Disabled Configuration mode is engaged. 
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9.0 Ethernet Data Communications 
The SmartVue is configured as a TCP/IP server and can send process, control process, 
I/O data, and Modbus commands and responses out through the Ethernet port.  Up to five 
concurrent TCP/IP connections can be made with the SmartVue. 

The screen image data can also be sent and displayed or controlled using the SmartVue 
Remote application described in Section 20.0. 

The SmartVue can accept ASCII formatted commands to request specific sets of data or 
cause it to stream on a continuous basis. 

9.1 Ethernet Settings 
To properly connect to the SmartVue over TCP/IP appropriate configuration settings are 
needed.  The Ethernet settings consist of the following: 

The IP address is a unique number that identifies a SmartVue or any other TCP/IP device 
on a network, so when requests for information are sent to it, it knows to respond.  No 
other TCP/IP devices on the network should have this address. 

The subnet mask, together with the IP address defines the network that the SmartVue 
belongs to and which IP addresses can be reached within it. 

Each IP address is divided into two parts: the shared network part and the unique host 
part.  When sending data to a device with a different network part, it must be sent through 
a router to reach its destination (i.e., to a different network).  If they are the same, no 
router is needed.  The host part sets how many unique IP address are allowed on the 
network.  So, with a subnet mask of 255.255.255.0 the first three parts of the IP address 
will form the fixed network number, while the last part of the IP address will allow for 
256 (0 to 255) different possibilities. 

The gateway IP address is the address of the device (such as a router) that serves as the 
interface between one network and another. 

The port number distinguishes command requests from any other type of request that the 
SmartVue may receive.  Responses will thus only be generated and returned if a 
command is sent to the SmartVue using this assigned port number.  Port numbers should 
be in the registered port range of 1024 to 49151. 

 To configure the SmartVue’s Ethernet settings 

1. Select MENU > Communications > Ethernet Settings.  The Ethernet Settings 
screen shown below will be displayed. 

2. Enable the Ethernet port using the Enabled/Disabled control at the top of the 
screen.  If the unit is connected to a network, the yellow LED on the connector 
will turn on and the green LED will flash in proportion to the amount of network 
traffic. When the control is set to “Disabled” the Ethernet port is disabled. 
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Figure 9-1  The Ethernet Settings screen 

3. Enter appropriate TCP/IP settings for your network. 

IP Address  This should be a unique IP address for the SmartVue.  No other 
TCP/IP devices on the network should have this address. 

Subnet Mask  The default of 255.255.255.0 should suffice in most instances. 

Gateway  The IP address for the network node (router) that connects your 
network to an outside network.  Typically, it shares the first 
three values of the IP address and uses 1 for the last value. 

4. Press OK . 

 
The Services button provides access to the various configurable features that are 
available for Ethernet communications. 

 
Figure 9-2  Ethernet Services Menu 

Note, settings for the following Ethernet services are described in the manual sections 
indicated below. 

Topic Section 
Streaming Data via Ethernet 9.2 
SmartVue Remote 20.0 
Modbus TCP Slave 12.1 
Modbus TCP Master 12.1 
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9.2 Streaming Data via Ethernet 
The SmartVue can stream process data, IO data, and J1939 SPN and DTC data via the 
TCP/IP port. 

Using the Auto Send feature, you can specify that certain data automatically begin 
streaming when the SmartVue is started without the need to first send a command to 
request it.  A new telnet session formed with the Auto Send feature turned on will also 
immediately begin to display data. 

Note: Auto Send settings and data are only updated when an active connection is enabled 
and started. 

 To configure the SmartVue to stream process data via TCP/IP 

1. On the Ethernet Settings screen, press Services then Data Streaming.  This will 
display the configuration screen for controlling how and what data will be 
streamed. 

2. Set Data Streaming to On. 

 
Figure 9-3  Ethernet Settings - Data screen 

3. Enter the data port number.  The software you use to send commands to the 
SmartVue must use this port.  The default port number is 2641. 

4. The Command Checksum setting is set to Off  by default; set it to On to include 
a checksum value at the end of each data line. 

The Off setting will accommodate testing and allow you to manually send 
commands to the SmartVue without having to include, and thus calculate, the 
checksum.  With the checksum turned on, commands will require that the 
correctly computed checksum value be included; without it an error response will 
be generated. 

5. Optionally, if you wish to select which sets of data will be sent automatically 
when the SmartVue is powered up, press Configure Auto Send.  This will 
display the Auto Send configuration screen. 

Set Auto Send to On to activate this feature. 
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Figure 9-4  Ethernet Settings – Configure Auto Send screen 

Select items from the Item column for the data sets you wish to receive.  Press 
Select All to check all the boxes at once or Deselect All to uncheck all of them.  
(Note, remember to save the SmartVue’s settings if you want your selection to 
persist after it has been powered off.) 

Also, optionally, if the J1939 communications stack is enabled then active 
Diagnostic Troubleshoot Codes (DTCs) can also be streamed for devices (ECUs) 
that have been added using the J1939 Diagnostics Configuration screen.  Press 
the J1939 DTCs button to display them and then select the ones you want to 
receive streamed data for by pressing the device name.  If the list is blank, no 
ECUs have yet been selected through the J1939 Diagnostics Configuration.  
(Refer to Section 10.7 for more information regarding DTCs.) 

 

Press OK  to accept your changes and then OK  again to return to the Ethernet 
Settings - Data screen. 

6. Press OK .  You should now be back on the Ethernet Settings screen. 

7. Press OK  to apply your changes. 

 
Note, if you already had an open telnet session to the SmartVue you were configuring 
Ethernet settings for (including Auto Send data), you must close it and start a new session 
to see the changes. 



SmartVue Operator’s Manual 

48  10-0004-R13 

9.3 Data Streaming Commands 
Commands can be sent to the SmartVue using an application capable of sending and 
receiving data via TCP/IP (e.g., PuTTY).  The SmartVue accepts commands in ASCII 
format and may be either uppercase or lowercase.  Each command begins with the letter 
“C” followed by a three-digit value indicating the type of command, and is terminated 
with a 16-bit checksum, as well as carriage return and line feed characters. 

For testing purposes, the command checksum can be disabled as mentioned in the 
previous section.  For example, if you wanted to conveniently obtain data or to test a 
connection via a Telnet session without having to calculate the checksum you can disable 
the checksum requirement. 

To help with the interpretation of command syntax, the following conventions are used. 

Bold is used for commands and options. 

Italic is used to show generic options that should be replaced with user-
supplied values. 

[ ] surround optional elements.  (The brackets themselves are not 
entered.) 

CS indicates the 16-bit, hexadecimal checksum value in the range 0000 to 
FFFF. 

<CRLF> represents the carriage return and line feed characters. 

Note that all connections to a SmartVue share the same interface, so sending a command 
with one connection will affect all other connections to it. 

The 16-bit checksum is generated by adding up all the bytes in a command (or a 
response) up to and including the comma before the checksum field while discarding any 
overflow bits.  Likewise, when data is received from the SmartVue, the received 
checksum can be verified the same way to ensure data integrity. 

Analog data is given in scientific notation with a decimal part and an exponential part.  
For example, a number like 538.2 will be displayed as 5.382000e+02, which means 
5.382000 × 102.  A value such as 0.4193 would be given as 4.193000e-01. 
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9.3.1 Stream Data Start (000) 

C000[,d1,d2,…dn][,CS]<CRLF> 

The Stream Data Start command enables the transmission of the SmartVue’s data packet 
once per second.  Options d1 to dn designate which data sets are to be returned.  The order 
in which the data set options are specified will determine the order in which they are 
returned. 

Note that the data stream will stop if the Poll Data command is executed. 

The data set options are given in the table below. 

Options 

P1 Process 1 
P2 Process 2 
P3 Process 3 
P4 Process 4 
C1 Control 1 
C2 Control 2 
IO Input/Output 
JD J1939 SPN Data 
Dn J1939 DTC, where n can be 1 to 16 
 

Examples 

Obtain the data set for Process 2 followed by Process 1. 

 C000,P2,P1[,CS]<CRLF> 

If the command is successful an OK response will be received and then the 
periodic data transmission will begin starting with the characters, D000. 

OK,R000,CS<CRLF> 
D000,SV009S000000,2011-06-30,15:51:00,P2,…data…,LENGTH,CS<CRLF> 
D000,SV009S000000,2011-06-30,15:51:01,P2,…data…,LENGTH,CS<CRLF> 
… 
Whenever a data set is received a length field is included and can be used in 
addition to the checksum to verify the integrity of the data.  The data length is 
calculated by adding the number of characters received starting with the serial 
number up to and including the comma before the LENGTH field. 

Obtain all data sets. 

 C000,P1,P2,P3,P4,C1,C2,IO,JD[,CS]<CRLF> 

Get the data packet header containing just the date, time and SmartVue serial number. 
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 C000[,CS]<CRLF> 

9.3.2 Stream Data Stop (001) 

C001[,CS]<CRLF> 

The Stream Data Stop command stops the continuous streaming of data packets.  Note 
the stream will also stop if the Poll Data command is sent. 

To stop the data stream use, 

 C001[,CS]<CRLF> 

If the command is successful, the following response will be returned: 

 OK,R001,01D5<CRLF> 

Note that 01D5 is the calculated checksum for this response. 

9.3.3 Poll Data (002) 

C002[,d1,d2,…dn][,CS]<CRLF> 

The Poll Data command works the same way as the Stream Data Start command, but 
only one data packet is returned, and it is included in the command response packet. 

Examples 

Obtain one complete data set. 

 C002,P1,P2,P3,P4,C1,C2,IO[,CS]<CRLF> 

If the command is successful an OK response will be transmitted with the data 
appended. 

OK,R002,SV009000000,2011-06-30,23:59:59,P1…data…[,CS]<CRLF> 

Refer to tables in section 9.4 Streamed Data Output, for a summary of the various 
data fields. 
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9.3.4 Error Responses 
If a command fails an error response beginning with the characters “ER” will be returned 
followed by an error code.  Error responses have the form, 

 ER,code[,command],CS<CRLF> 

The following error codes may be encountered. 

BUF indicates a command buffer overflow. 

CMD means that an invalid command was received. 

CSM indicates a checksum error.  In this case the command was 
likely corrupted in transmission and should be resent. 

DUP indicates a duplicate parameter was received.  The sent 
command will also be returned with this error. 

PAR means an invalid parameter was received.  The sent command 
will also be returned with this error. 
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9.3.5 Testing with Telnet 

While a Telnet client is included with Microsoft Windows® it is not recommended for 
communicating with the SmartVue.  A suggested program is PuTTY, which is freely 
available at http://www.chiark.greenend.org.uk/~sgtatham/putty/.  It can be installed with or 
without an installer. 

 To send commands to the SmartVue using PuTTY 

1. Connect the SmartVue to your network and configure its TCP/IP settings as 
described in the previous procedure. 

2. On the SmartVue, press MENU > Communications > Ethernet Settings and set 
the Checksum to Off . 

3. Run the PuTTY  program on your PC. 

4. Enter the IP address, Port number and a Connection type of Telnet as shown in 
the program window below.  You can also give the session a name (i.e., 
“SmartVue”) and save it for easy retrieval later. 

  

5. Select your newly saved session and then click Open or simply double-click its 
name to connect and begin the Telnet session. 

6. If data is not already streaming, you could enter a command like, C000,P1 to turn 
on streaming and continuously return data for Process 1.  New commands can still 
be entered while data is streaming. 

7. When you are done testing, click the icon in the upper right to display the 
program menu and select Close. 



  SmartVue Operator’s Manual 

10-0004-R13  53 

9.4 Streamed Data Output 
Streamed data output packets consist of a header plus any user selected data sets, Pn, Cn, 
IO, JD and/or Dn followed by the data length in bytes.  The following tables summarize 
the contents of the data packet components. 

Data Header  
Field Label  Field Name  Data 

SN Serial Number String (12 Characters) 
D Date (YYYY-MM-DD) String (10 Characters) 
T Time (24 Hour Format) (HH:MM:SS) String (8 Characters) 

 

Process Data Section 

Process Type*/ 
Input Type 

Field Label Field Name Data Units 

DT Data Type (P = Process) P1,P2,…P8  
0/NA PT Process Type (0 = Off ) 0  

1/1,2,3, or 5 

PT Process Type (1 = Standard) 1  

IT Input Type  
(1=CLI, 2=VI, 3=DI, 5=TEMP) Integer  

IC Input Channel (1-6) Integer  
SPDATA1 Scaled Process Data Float User specified 

1/6 

PT Process Type (1 = Standard) 1  
IT Input Type (6=Total/Rate) 6  
IC Input Channel (1-7) Integer  

SPDATA1 Scaled Process Data 1 (Rate) Float User specified 
SPDATA2 Scaled Process Data 2 (Total) Float User specified 

1/7 

PT Process Type (1 = Standard) 1  
IT Input Type (7=SPN Analog) 7  
IC Input Channel (1-32) Integer  

SPDATA1 Scaled SPN Data Float User specified 

1/8 

PT Process Type (1 = Standard) 1  
IT Input Type (8=SPN State) 8  
IC Input Channel (1-32) Integer  

SPDATA1 Raw State Data in decimal Integer none 

1/9 

PT Process Type (1 = Standard) 1  

IT 
Input Type 
(9=Scaled Modbus Data) 9  

IC User Register (401-464) Integer  
SPDATA1 Scaled Modbus Data Float User specified 

* The Process Type (PT) field can also contain an error bit at position 0x10 that is OR’d with the process type value 
when a process has an error (i.e., if the process is invalid, or the process has an error, such as an RTD connection 
error or if a J1939 SPN times out, etc.)  Thus, if the expected value is 1 for the Process Type, but the process is 
experiencing an error situation, the PT field will have the decimal value 17 (0x01 OR’d with 0x10 = 0x11 or 17 
decimal). 
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Control Data Section 
Control 

Type 
Field Label Field Name Data Units 

DT Data Type (C = Control) C1 or C2  

0 CT Control Type (0 = Off) 0  

1 CT Control Type (1 = PID) 1  

FBIT Feedback Input Type (1,2,5 or 6) Integer  

FBIC Feedback Input Channel (1-7) Integer  

MV Modified Variable Float User specified 

FB Feedback Float User specified 

ERR Error Float User specified 

SP Setpoint Float User specified 

RES Reserved Float  

ITERM I Term Float User specified 

DTERM D Term Float User specified 

2 CT Control Type 
(2 = PID w/External SP) 

2 
 

FBIT Feedback Input Type (1,2,5 or 6) Integer  

FBIC Feedback Input Channel (1-6) Integer  

SPIT Setpoint Input Type (1,2,5 or 6) Integer  

SPIC Setpoint Input Channel (1-6) Integer  

MV Modified Variable Float User specified 

FB Feedback Float User specified 

ERR Error Float User specified 

SP Setpoint Float User specified 

RES Reserved Float  

ITERM I Term Float User specified 

DTERM D Term Float User specified 

3 CT Control Type 
(3 = PID External SP w/Multiplier) 

3 
 

FBIT Feedback Input Type (1,2,5 or 6) Integer  
FBIC Feedback Input Channel (1-6) Integer  
SPIT Setpoint Input Type (1,2,5 or 6) Integer  
SPIC Setpoint Input Channel (1-6) Integer  
MV Modified Variable Float User specified 

FB Feedback Float User specified 

ERR Error Float User specified 

SP Setpoint Float User specified 

RES Reserved Float  

ITERM I Term Float User specified 

DTERM D Term Float User specified 

* The Control Type (CT) field can also contain an error bit at position 0x10 that is OR’d with the control type value 
when a control process has an error (i.e., if the control process is invalid, or it has an error, such as an RTD 
connection error or if a J1939 SPN times out, etc.)  Thus, if the expected value is 1 for the Control Type, but the 
control process is experiencing an error situation, the CT field will have the decimal value 17 (0x01 OR’d with 0x10 
= 0x11 or 17 decimal). 
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Input/Output Data Section  
Field Label  Field Name  Data Units  

DT Data Type (IO = Input/Output) IO  
MDIM Monitor Data Input Mask 0-3FFFFF (ASCII)  
MDOM Monitor Data Output Mask 0-FFF (ASCII)  
TEMPSS Temperature Sensor Status Integer  
TEMP Temperature Float °C 
TACH1 Tachometer Rate 1 Integer   Hz 
TACH2 Tachometer Rate 2 Integer   Hz 
CTR1 Counter Rate 1 Integer   Hz 
CTR2 Counter Rate 2 Integer   Hz 
CTR3 Counter Rate 3 Integer   Hz 
QUAD1 Quadrature Rate 1 Integer   Hz 
QUAD2  Quadrature Rate 2 Integer   Hz 
CLI1 Current Loop In 1 Float mA 
CLI2 Current Loop In 2 Float mA 
VI1 Voltage In 1 Float V 
VI2 Voltage In 2 Float V 
VI3 Voltage In 3 Float V 
VI4 Voltage In 4 Float V 
VI5 Voltage In 5 Float V 
VI6 Voltage In 6 Float V 
DI1 Digital In 1 Integer    
DI2 Digital In 2 Integer    
DI3 Digital In 3 Integer    
DI4 Digital In 4 Integer    
DI5 Digital In 5 Integer    
DI6 Digital In 6 Integer    
CLO1 Current Loop Out 1 Float mA 
CLO2   Current Loop Out 2 Float mA 
VO1 Voltage Out 1 Float V 
VO2 Voltage Out 2 Float V 
FO1 Frequency Out 1 Float Hz 
FO2 Frequency Out 2 Float Hz 
DO1 Digital Out 1 Integer    
DO2 Digital Out 2 Integer    
DO3 Digital Out 3 Integer    
DO4 Digital Out 4 Integer    
DO5 Digital Out 5 Integer    
DO6 Digital Out 6 Integer    
STEMP Scaled Temperature Float User specified 
STACH1 Scaled Tachometer Rate 1 Float User specified 
STACH2 Scaled Tachometer Rate 2 Float User specified 
SCTR1 Scaled Counter Rate 1 Float User specified 
SCTR2 Scaled Counter Rate 2 Float User specified 
SCTR3 Scaled Counter Rate 3 Float User specified 
SQUAD1 Scaled Quadrature Rate 1 Float User specified 
SQUAD2  Scaled Quadrature Rate 2 Float User specified 
SCLI1 Scaled Current Loop In 1 Float User specified 
SCLI2 Scaled Current Loop In 2 Float User specified 
SVI1 Scaled Voltage In 1 Float User specified 
SVI2 Scaled Voltage In 2 Float User specified 
SVI3 Scaled Voltage In 3 Float User specified 
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Input/Output Data Section  
Field Label  Field Name  Data Units  

SVI4 Scaled Voltage In 4 Float User specified 
SVI5 Scaled Voltage In 5 Float User specified 
SVI6 Scaled Voltage In 6 Float User specified 
SCLO1 Scaled Current Loop Out 1 Float User specified 
SCLO2   Scaled Current Loop Out 2 Float User specified 
SVO1 Scaled Voltage Out 1 Float User specified 
SVO2 Scaled Voltage Out 2 Float User specified 
SFO1 Scaled Frequency Out 1 Float User specified 
SFO2 Scaled Frequency Out 2 Float User specified 

 

Input Channel Table  

Input Type  
               Channel# 
Input Type#  1 2 3 4 5 6 7 

Current 
Loop Input 1 4-20mA IN 1 4-20mA IN 2           
Voltage 
Input 2 VIN 1 VIN 2 VIN 3 VIN 4 VIN 5 VIN 6   

Digital Input 3 DIO 1 DIO 2 DIO 3 DIO 4 DIO 5 DIO 6   

Reserved 4               
Temperature 
Input 5 RTD             
Total/Rate 
Input 6 TACH IN 1 TACH IN 2 CTR1 CTR2 CTR3 QENC1 QENC2 

 

Temperature Sensor Status 
(TEMPSS) Description  

0 No Error 
1 RTD Connection Error 
2 Reading Under 
3 Reading Over 

 

J1939 SPN Data 
Field Label Field Name Data Units 

DT Data Type (JD = J1939 SPN Data) JD  

NUM Number of SPNs Integer  

SPN1 SPN Data 
Float if Analog, 
Integer if State 

User Specified 

… SPN Data Float if Analog, 
Integer if State 

User Specified 

SPNn SPN Data Float if Analog, 
Integer if State 

User Specified 

Note: Each SPN data field may also be three zeros (000) if J1939 is disabled or a data error or 
two zeros (00) if the SPN is disabled. 
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J1939 DTC Data 
Field Label Field Name Data Units 

DT Data Type (D = J1939 DTC Data) D1...D16  

ECU ECU Address Integer  

NCODES Number of Codes Integer  

DTC1 SPN Number Integer  

FMI1 SPN Data Integer  

OC1 Occurrence Count Integer  

…    

DTCn SPN Number Integer  

FMIn SPN Data Integer  

OCn Occurrence Count Integer  
Note: The ECU address data field may also be three zeros (000) if J1939 is disabled or a data error 
or two zeros (00) if the DTC slot is disabled. 
 

Modbus User Registers 
Field Label Field Name Data Notes 

DT Data Type (M = Modbus Data) M1...M5 

M1 – unsigned 16-bit integers group 
M2 – signed 16-bit integers group 
M3 – unsigned 32-bit integers group 
M4 – signed 32-bit integers group 
M5 – 32-bit floats group 

MBxxx 1st Modbus register in the group integer or float xxx = 401, 409, 417, 433 or 449 

… … … … 

MBxxx 8th Modbus register in the group integer or float xxx = 408, 416, 431, 447 or 463 

 

Example: A simple data packet including a single Te mperature process, P4 

D000,SV009S001026,2012-07-24,08:58:42,P4,1,5,1,2.317000e+01,0037,0D46 

 
D000 Streamed data response 

SV009S001026 SmartVue serial number 

2012-07-24,08:58:42 Date/timestamp 

P4 Beginning of Process 4 data set 

1 Process type: Standard 

5 Input type: Temperature 

1 Input channel: 1 

2.317000e+01 23.17 °C 

0037 Length in bytes (hexadecimal) 

0D46 Checksum (hexadecimal) 
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10.0 SAE J1939 Communications 
The Society of Automotive Engineers (SAE) developed the J1939 bus standard to allow 
equipment used in industry to communicate with one another and report on the states of 
various systems.  J1939 thus forms the basis for the popular Controller Area Network 
(CAN) protocol, which communicates on a simple dual-wire, serial interface and 
facilitates the exchange of data between electronic control units (ECUs) in automotive, 
aerospace, agricultural, and factory automation systems.  A multitude of parameters can 
be monitored on a CANbus including such things as torque control, engine speed, engine 
oil temperature, throttle position, and much more. 

The following diagram shows how the SmartVue can be connected to a CANbus. 

 
  

1
  

 2
  

 3
  

4
  

 5
  

 6
 

 

Messages transmitted on the J1939 network include values that identify data being 
requested or sent by ECUs.  Among other things, each message contains a Parameter 
Group Number (PGN), source address, and priority.  If the message is intended to be 
peer-to-peer, it will also include a target address that has made the request for the 
information. 

Parameters that have common characteristics are grouped together into a Program Group 
(PG) identified by the PGN.  The J1939 standard defines the specific data parameters that 
are associated with each PGN and how they are arranged.  Each parameter is, in turn, 
identified by a Suspect Parameter Number (SPN).  For example, PGN 65269 describes a 
set of data values that provide information about the ambient temperature and pressure 
conditions. 

PGN 65269 Ambient Conditions 

SPN Parameter Name   
108 Barometric Pressure 
170 Cab Interior Temperature 
171 Ambient Air Temperature 
172 Engine Air Inlet Temperature 
79 Road Surface Temperature 
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Figure 10-1  The J1939 menu 

10.1 Configuration 
Press Configuration  on the J1939 menu to access the setup screens for J1939 
communications. 

Top level configuration of the J1939 protocol consists of setting the mode, standard and 
type of addressing that will be used for communications. 

     
Figure 10-2  J1939 Configuration with an address type of Arbitrary 

     
Figure 10-3  J1939 Configuration with an address type of Fixed 

 
Mode 

• Monitor Only  – This mode option permits the monitoring of active PGN data on 
the J1939 bus.  The SmartVue will not send any requests for additional PGNs.  
(The CANbus interface will be deactivated in this mode.) 

• Send & Receive  – With this setting the SmartVue will be identified on the network 
as an ECU with its own address.  In addition to being able to monitor SPN data, 



SmartVue Operator’s Manual 

60  10-0004-R13 

the SmartVue will be allowed to make requests for new PGNs that aren’t already 
active on the J1939 bus.  Note, that this will add additional traffic to the J1939 
network, which should be avoided unless necessary to get SPN data that is not 
already available. 

• Disabled  – With this option setting, the J1939 communications stack will not be 
initiated and SPN or DTC monitoring on the bus will not be possible. 

Standard 
The communications standard defines the set of rules for how information is to be 
transmitted on a communications bus including the type of data that is to be expected and 
how it should be arranged and deciphered. 

• J1939-11 – This standard is used for control and communications on commercial 
and heavy duty vehicles as well as other equipment, to provide information from 
engine, brake, and transmission controllers, among others. 

• ISO11783 (ISOBUS) – Based on the J1939 communications standard, the ISOBUS 
standard defines a more specific set of data for control and communications on 
equipment and machinery used in the agricultural and forestry industries.  Only 
Arbitrary addressing is used if this standard is selected. 

The following options can only be set if the J1939 operating mode is set to Send & 
Receive.  If you wish to obtain particular SPN data that is not actively on the bus then the 
SmartVue must claim and address and identify itself on the bus to make the request for a 
PGN that includes the desired data. 

Address Type 

• Arbitrary  – Should a conflict occur when a claim is made for the Default Address 
(see below) an attempt will be made to claim another. 

• Fixed  (J1939-11 only) – A SmartVue with a fixed address will not attempt to 
make a claim for a new address should a conflict with another ECU occur on the 
bus, but will instead wait for it to become available. 

Default/Fixed Address  – This is the address by which the SmartVue will be identified on 
the J1939 network.  It may be a value from the general address pool of 128 to 247 
inclusive.  The default address is 137 but may be changed to any value within the given 
range. 

Obtain Device List on Startup?  – If Yes, the SmartVue will check the bus for ECUs that 
are actively transmitting messages when the SmartVue is powered up and list them on the 
Active Device List screen.  This adds a modicum of traffic to the J1939 bus when the 
SmartVue is started. 

Use available/any (address)  – If set to available, the SmartVue will use only use an 
address that is not currently in use on the J1939 bus.  If any is selected (Arbitrary address 
type only), then a claim for any address within the specified range will be made.  The 
overall range is 128 to 247 but may be limited if desired. 
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Function  – The SmartVue will be identified on the bus as a System Monitor (function 33) 
by default.  A function with a lower number will have a high priority when it comes to 
message handling on the network. 

Function Instance  – This value allows you to differentiate the SmartVue from any other 
device on the network that may also have the same function, but different instance value. 

10.2 Active Device List 
What information is available on the bus (or can be requested to be on the bus) depends 
on which devices (ECUs) are connected and active on the network. 

To see the list of active devices on the network, select MENU > Communications > 
J1939 Menu > Active Device List. 

 
Figure 10-4  The J1939 Active Device List 

The Active Device List shows the list of devices that are communicating on the CAN 
bus.  Each device sends a name describing its function along with its address. 

To get more information about a specific device, select its function name and then press 
the Info  button. 

 
Figure 10-5  Active Device Info screen 
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10.3 SPN List 
The SPN list shows the list of SPNs that have been selected for monitoring either on the 
SPN Data Monitor screen or on the SmartVue’s Meter screen.  Up to 32 SPNs may be 
added to the list. 

10.3.1 Add an SPN to the List 
 

 To add to the SPN List from the list of active SPNs 

1. Select SPN List from the J1939 Menu. 

2. Choose a row that has nothing entered in it by selecting the area in the Label 
column.  (Notice that the selectable areas on this screen have a light grey 
background color). 

3. Press the Add button. 

 

4. Press the Search button to search for, and select, the desired SPN. 

You can conveniently select from a list of active PGNs or SPNs.  In the example 
figures below, the SPN button was pressed and then SPN 110 was selected. 

     

Press OK  to return to the SPN Search screen.  You’ll notice detailed information 
related to the selected SPN is now displayed. 
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5. Press OK  to return to the SPN Configuration screen. 

6. Select All Devices for the Addressing mode. 

If you know the address of the device (ECU) that is supplying the data for the 
selected SPN you could specify an addressing mode of Fixed (By Address) and 
then enter the address.  Likewise, if you have a user defined device you can select 
an addressing mode of Arbitrary (By Name) and then press the Device List button 
to select it. 

7. Enter an appropriate label in the Label box to that will descriptively identify the 
parameter on the SPN (Data) Monitor screen. 

8. Press OK .  The SPN List now shows the newly added SPN. 

 

 
You can edit an existing SPN by selecting its label and pressing the Edit  button. 

To delete an SPN from the list, select its label and press Delete. 
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10.4 SPN (Data) Monitor 
The SPN (Data) Monitor screen is used to monitor any SPN data selected using the SPN 
List.  Up to 16 separate SPNs may be monitored. 

 
Figure 10-6  The SPN (Data) Monitor screen 

 

Rapid SPN Changes 
If an SPN data value changes very quickly, events that occur within a half-
second window could be missed because of their short duration and the inherent 
nature of the discrete sampling. 

 

10.4.1 Display SPN data on the Meter Screen 
You can also display SPN data values on the SmartVue’s Meter screen in the same way 
that I/O data is displayed.  When setting up a process, simply select a process type of 
J1939 SPN, the Input spinner control will list the active SPNs that are included on the 
SPN List.  The meter can display analog SPN value as either a digital or history graph, as 
in the example figures below. 
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10.5 User Device List 
Any device from which you wish to request one or more PGNs (to thus get subsequent 
SPN data) will be added to the User Device List. 

 To add a device to the User Device List 

1. Select User Device List from the J1939 Menu. 

2. Choose a row that has nothing entered in it by selecting the area in the Device 
Name column.  (Notice that the selectable areas on this screen have a light grey 
background color). 

3. Press the Add button. 

4. Enter an appropriate name for the device.  Configure the various fields. 

      

5. Press OK .  The newly added device will appear on the list. 
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10.6 PGN Request List 
The PGN Request List is used to select PGNs that for which related SPN data is desired 
but is not already being transmitted on the bus. 

 To select additional PGNs to be transmitted on the bus by any (or all) available 
ECUs 

1. Select PGN Request List from the J1939 Menu. 

2. Choose a row that has nothing entered in it by selecting the area in the Device 
(ECU) column.  (Notice that the selectable areas on this screen have a light grey 
background color). 

3. Press the Add button. 

 

4. Press the Search button to display the SPN Search screen and then search by 
PGN or SPN to obtain the PGN you need. 

5. Select a device to choose the ECU you want to begin transmitting the data for the 
PGN you selected. 

If you know the address of the device (ECU) that is supplying the data for the 
selected SPN you could specify an addressing mode of Fixed (By Address) and 
then enter the address or use the Active List button to choose it.  Likewise, if you 
have a user defined device you can select the Arbitrary (By Name) addressing 
mode and then press the Device List button.  The All Devices option will cause all 
ECU to transmit the selected PGN data if it can. 

6. Enter an interval for how often that data should be transmitted.  A value of zero 
means that the data will be transmitted only once the ECU is started up. 

7. Press OK . 



  SmartVue Operator’s Manual 

10-0004-R13  67 

10.7 Diagnostic Trouble Codes 
The SmartVue can monitor diagnostic messages, commonly referred to as DM messages, 
from a selected device on the network.  The SmartVue supports DM1 messages, which 
provides a list of diagnostic trouble codes (DTCs) that are currently active on the device.  
Up to ten active DTCs can be monitored from a selected ECU (even though a device may 
transmit more than ten).  Each DTC incorporates the diagnostic lamp statuses, the source 
SPN, the SPN Conversion Method (CM) †, a Failure Mode Identifier (FMI) and the 
Occurrence Count (OC). 

10.7.1 Configuration 
 

 To monitor any active DTCs that may be on the bus 

1. Select Diagnostics Config from the J1939 Menu. 

2. Choose a row that has nothing entered in it by selecting the area in the Device 
(ECU) column.  (Notice that the selectable areas on this screen have a light grey 
background color). 

3. Press the Add button. 

4. Choose the device you wish to monitor for DTCs. 

You can choose a device by using the Fixed (By Address) addressing mode.  In 
this case enter an ECU address or choose a device from the Active Device List by 
pressing the Active List button and selecting it.  Alternatively, you can choose a 
device from the User Device List using the Arbitrary (By Name) addressing mode. 

Press OK  to return to the Diagnostics Configuration screen. 

 

5. Press OK . 

 

 
† The Conversion Method (CM) specifies how the bits identifying the SPN should be converted into the actual SPN 
value.   The recommended standard, Version 4, is assumed. 
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10.7.2 Viewing Active DTCs 
DTCs can be viewed using the Active DTC Monitor screen (J1939 – Menu > 
Diagnostics Display). 

There are two sets of four lamps: MIL, STOP, WARNING, and PROTECT.  Depending 
on the trouble code, one or more of these lamps will light up or flash to indicate the 
severity of the problem.  A rapid flash (about 1 Hz) indicates a problem with a greater 
severity than if it were flashing slowly (about 2 Hz), and a slow flash has a higher 
severity than no flash (but illuminated). 

There are two portions to the screen. The upper portion of the screen shows the combined 
lamp states for all the DTC messages from the indicated ECU.  Thus, if one DTC were to 
cause the Malfunction Indicator lamp to be illuminated and another DTC to cause the 
Warning lamp to be illuminated, they will both be illuminated simultaneously. 

     
Figure 10-7  The Active DTC Monitor screen 

On the lower portion of the screen, you can page though each DTC for the selected ECU 
by using the arrow buttons.  The lower lamps will indicate the severity for the single 
DTC only.  In this case, different DTC may illuminate the lamps differently. 

You can cycle through the list of selected devices using the arrow buttons to examine the 
combined lamp states. 

Table 10-1  Status lamps and their meanings 

MIL (Malfunction Indicator Lamp) This lamp is used to relay trouble code information related 
exclusively to emissions-related issues.  It will illuminate 
only when there is an active emissions-related DTC. 

Red Stop Lamp Trouble code information that is of a severe enough 
condition that stopping the vehicle is warranted will cause 
this lamp to illuminate. 

Amber Warning Lamp A DTC for a problem with the vehicle system where the 
vehicle does not need to be immediately stopped will cause 
this lamp to illuminate. 

Protect Lamp This lamp is used to relay trouble code information for a 
problem that is probably not electronic subsystem related. 
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DTC Icon 
If there are one or more devices listed on the J1939 Diagnostics 
Configuration screen and one (or more) is transmitting a DTC, then 
the DTC icon shown here will be displayed in the upper right 
corner of the display. 
 

 

11.0 Serial Data Communications 
The SmartVue is equipped with one RS-232 serial interface and one RS-485 serial 
interface for serial data communications.  Each is independent of the other and can have 
their own separate configuration settings.  The following serial communications modes 
are available: 

Stream – Textual lines with comma separated fields of data selected from process 
data, IO data, and J1939 SPN, and DTC data.  The data output is organized with 
the same format as Ethernet data communications described in section 9.4. 

MB Master/Slave ASCII – (Used for Modbus serial communications) Modbus 
ASCII uses ASCII characters to represent the data and uses LRC error checking.  
More bytes are needed to transmit message content than with MB RTU. 

MB Master/Slave RTU – (Used for Modbus serial communications) Modbus RTU 
uses binary coding and CRC error checking.  Fewer bytes are needed to transmit 
message content than with MB ASCII. 

Since MB ASCII and MB RTU are incompatible, you must know how the device that the 
SmartVue is communicating with is configured and then configure the SmartVue to use 
the same method.  Refer to section 12.0 for setting up Modbus Register. 

 
Figure 11-1  Wiring to hook up a serial RS232 device 
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Note, settings for the following Ethernet services are described in the manual sections 
indicated below. 

Streaming Data Serially  11.1 
Transmitting Modbus Data Serially 12.0 

 

11.1 Streaming Data Serially 
The SmartVue can stream process data, IO data, J1939 SPN & DTC data and Modbus 
user registers via the serial RS-232 and RS-485 ports. 

Using the Auto Send feature, you can specify that certain data automatically begin 
streaming when the SmartVue is started without the need to first send a command to 
request it.  A new terminal session formed with the Auto Send feature turned on will also 
immediately begin to display data. 

As with Ethernet data communications, commands can be sent to the SmartVue using a 
serial terminal application.  (An example application is discussed in a later section.)  
Refer to section 9.3 for the command syntax. 

Likewise, for testing purposes the command checksum can be disabled.  For example, if 
you want to conveniently obtain data or to test a connection via a Telnet session without 
having to calculate the checksum you can disable the checksum requirement. 

 To configure the SmartVue to stream process data via RS-232 

1. Select MENU > Communications > Serial Settings > RS232 Settings.  (Select 
RS485 Settings if you wish to use the RS485 interface.) If the serial interface is 
off, you will see a single control called Serial Mode. 

2. Set the Serial Mode control to Stream.  (Note: selecting Off, shuts off the serial 
communications interface.)  This will display the screen shown below. 

 
Figure 11-2  RS232 Settings 

3. Set the Baud Rate to the desired value.  Options include: 600, 1200, 2400, 4800, 
9600, 14400, 19200, 38400, 57600, and 115200. 

4. Set the Parity .  The options are Odd, Even, or None. 
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5. The Command Checksum setting is set to Off  by default.  The Off setting will 
accommodate testing and allow you to manually send commands to the SmartVue 
without having to include, and thus calculate, the checksum.  With the checksum 
turned on, commands will require that the correctly computed checksum value be 
included; without it an error response will be generated. 

6. Optionally, if you wish to select which sets of data will be sent automatically 
when the SmartVue is powered up, press Configure Auto Send.  This will 
display the Auto Send configuration screen. 

Set Auto Send to On to activate this feature. 

 
Figure 11-3  RS232 Settings – Configure Auto Send screen 

Select items from the Item column for the data sets you wish to receive.  Press 
Select All to check all the boxes at once or Deselect All to uncheck all of them.  
(Note, remember to save the SmartVue’s settings if you want your selection to 
persist after it has been powered off.) 

Also, optionally, if the J1939 communications stack is enabled then active 
Diagnostic Troubleshoot Codes (DTCs) can also be streamed for devices (ECUs) 
that have been added using the J1939 Diagnostics Configuration screen.  Press the 
J1939 DTCs button to display them and then select the ones you want to receive 
streamed data for by pressing the device name.  If the list is blank, no ECUs have 
yet been selected through the J1939 Diagnostics Configuration.  (Refer to Section 
10.7 for more information regarding DTCs.) 

 

Press OK  to accept your changes and then OK  again to return to the previous 
screen. 

7. Press OK .  You should now be back on the initial RS232 Settings screen. 
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8. Press OK  to apply your changes. 

 
Section 9.3 described the use of a program called PuTTY to use with Ethernet data 
communications.  Here we will demonstrate how to use it to communicate with the SmartVue 
serially. 
 
The two screens below show how PuTTY is configured to communicate over comport 4 (called 
COM4) at 9600 baud with no parity.  Note that the SmartVue uses 8 data bits and no flow 
control by default so the PuTTY configuration should also reflect this. 
 

     
Figure 11-4  Serial communications using PuTTY 

Save the configured session and click Open to observe the streaming data.  This figure below 
shows RTD temperature data coming from Process 1. 
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Figure 11-5  Sample serial data using PuTTY 
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12.0 Modbus Communications 
Modbus is a communications protocol that is widely used in industry to connect multiple 
devices on the same network.  It is a command, then response, protocol whereby a master 
device initiates by sending a request and a slave device responds to that request.  A 
master’s command is a read from, or a write to, the slave’s Modbus registers. 

These Modbus registers are named Input, Holding, Coil, and Discrete.  These are old 
PLC concepts used in the Modbus commands.  SmartVue has data “registers” that are 
accessible using these Modbus registers specified in the commands.  For example, the 
same SmartVue Process Registers can be read by a Master sending a read input register 
or read holding register command. 

 

Figure 12-1 Example setup showing the many ways to connect Modbus devices. 

The SmartVue can act as a master or a slave device and can use its Ethernet or serial port 
interfaces to transmit data using the Modbus protocol to other Modbus-capable devices.  
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A master can only write to a slave’s writable holding registers (and coil registers).  In 
SmartVue, we call these writable holding registers: User Registers. 

Our implementation of SmartVue as a Modbus master transfers/copies data between 
SmartVue’s Modbus registers and the slave’s Modbus registers. 

SmartVue registers can be a single-bit, 16-bit integers, 32-bit integers or 32-bit floats. 

Appendix 21.4 lists the complete Modbus register mappings for reading all the 
SmartVue’s I/O points, the user configurable register assignments related to any active 
process along with possible error codes, the J1939 SPN and DTC data and statuses at 
their fixed register locations as well as a set of writable Modbus user registers.  There are 
different ways to address the registers: Offset, Register and Modicon.  The SmartVue 
config screens use the Register column in the tables. 

 
What you can NOT do with this Modbus implementation  
• Modbus UDP is not supported - only Modbus TCP (Ethernet), RTU (serial) 

and ASCII (serial) are supported. 
• The SmartVue’s configuration parameters cannot be changed via Modbus – 

only the transfer of data for display and control is permitted. 
• There is limited usage of coils and bits. The SmartVue, as a master, cannot 

read or write to a slave’s coils or discrete inputs.  However, the SmartVue’s 
discrete inputs can be read by a connected master. 
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Figure 12-2  The multitude of Modbus configuration screens that are accessible. 

12.1 Reading Process Data via Ethernet (TCP) 
 To configure the SmartVue as a Modbus slave for TCP communications 

1. Select MENU > Communications > Ethernet Settings. 

2. Enable the Ethernet feature and configure the network settings as per Section 9.1. 

3. Press the Services button and then the Modbus TCP Slave button. 

4. Set the Enabled option to Yes.  This will display the screen shown below. 

 
Figure 12-3  Modbus TCP slave configuration settings 
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5. Set the register order for multi-register, 32-bit floating point and integer values as 
needed.  If set to Low First , the low order register is transmitted first.  Likewise, 
if set to High First , the high order register is transmitted first. 

6. Set the TCP Port.  By default, Modbus TCP uses port 502. 

7. Set the Response Delay to a value between 0 and 5000 ms. 

This is the delay that the SmartVue will add before transmitting the response.  
The default is 50 ms.  This may be required for communications paths that have a 
half-duplex part like RS485. 

8. Set the Activity Timeout  to a value between 1 and 100 seconds. The default is 30 
seconds. 

This is the amount of time since the last master transmission before SmartVue 
closes the TCP connection due to no activity.  If a master drops a TCP connection 
the SmartVue may not be notified, so a timer is used to detect if the master is no 
longer connected.  Since the SmartVue only has three possible slave connections 
it important to keep this time short.  You can see the current connections in the 
Comm. Diagnostics area under the Communications > Modbus Regs & Diag 
menu. 

9. Press OK  to apply your settings. 

 

The SmartVue can be configured as a Modbus master to poll data from other slave 
devices. 

 To configure the SmartVue as a Modbus master for TCP communications 

1. Select MENU > Communications > Ethernet Settings. 

2. Enable the Ethernet feature and configure the network settings as per Section 9.1. 

3. Press the Services button and then the Modbus TCP Master button. 

4. Set the Enabled option to Yes.  This will display the screen shown below. 

 
Figure 12-4  Modbus TCP Master Connections list 

5. Press the Add button to display the following screen.  The maximum number of 
TCP master connections is five. 
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Figure 12-5  Modbus TCP Master Connection configuration 

6. Enter the IP Address of a slave device you want to poll data from. 

7. Set the TCP Port.  By default, Modbus TCP uses port 502. 

8. Set the Conn Timeout value. This specifies how long (in seconds) to wait for the 
TCP connection to be established.  If it times out or fails for any other reason, 
then it will wait the Cycle Delay before retrying. 

9. Set the register order for multi-register, 32-bit floating point and integer values as 
needed.  If set to Low First , the low order register is transmitted first.  Likewise, 
if set to High First , the high order register is transmitted first. 

10. Set additional parameters: 

Cmd Delay (ms) – (Command Delay) This specifies the delay between 
commands.  After receiving a response there will be a delay of at least this 
amount before the next command is sent.  This may be required for 
communications paths that have a half-duplex part like RS485. 

Cycle Delay (ms) – This is how long the SmartVue will wait after receiving the 
response from the last command in the polling table before starting a new cycle. 

Rsp Timeout (ms) – (Response Timeout) This is how long the SmartVue will 
wait for the slave to respond. 

Cmd Retries – (Command Retries) This is how many times to retry the last failed 
command before moving on to the next command in the polling table.  If you 
have a high cycle delay you may want to use this feature.  The command delay 
will be used between retries. 

11. Press the Polling Table button to display a list of all the commands the SmartVue 
will send for the given TCP connection. 
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12. Press Add to add a slave address to the list.  You will see a screen like the one 
below. 

Note, you can edit an existing item from the list by selecting its function in the 
Function column and pressing Edit . 

 

13. Set the Master Command configuration options for the slave device register(s) 
you are polling. 

Slave Address – the slave device address you wish to poll.  For TCP this is 
usually ignored since the IP Address identifies the device.  However, some 
devices contain multiple virtual slaves or relay the communication to other 
attached slaves. 

Slave Function – the Modbus function you wish to execute, which include: 

Function Number Description 

Read Holding: 3 Read from the slave’s holding registers into the SmartVue’s user registers. 

Read Input: 4 Read from the slave’s input registers into the SmartVue’s user registers. 

Write Single: 6  Read from SmartVue’s register and write to the slave’s holding register. 

Write Multiple: 16  Read from SmartVue’s registers and write to the slave’s holding registers. 

 As you change between the read and write functions the “To” and “From” labels 
swap on the following two register fields. 

From/To Slave Register – the starting register on the slave device to read 
from/write to.  In the polling table screen, this is indicated in the SL Reg column.  
The Dir  column indicates the direction data is moving: a read function from the 
slave to the SmartVue pointing right, or a write function from the SmartVue to the 
slave pointing left. 

To/From SmartVue Register – When configuring a slave write function you can 
specify any of the SmartVue registers (I/O, Process/Control, SPN, DTC or User) 
to read from.  If you are setting up a slave read function then only a SmartVue 
user register should be specified – you will see a red warning if not and the 
command will fail.  There is a Pick User Reg button beside the number box to 
help find the user register.  To find the other register numbers you will need to 
consult the Modbus register listings at the end of this manual.  This register is 
displayed in the SV Reg column of the Polling Table. 

Number of Registers – the number of 16-bit Modbus registers to transfer. 

14. Press OK . For our example, we are reading a single 16-bit integer from slave 
register 1 into SmartVue register 401, as the screen below indicates. 
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15. Press OK .  Press OK  again to return to the Modbus TCP Master Connections 
screen. The screen below for this example configuration now shows the slave IP 
address, port, command delay, cycle delay, response timeout, command retries, 
and number of commands. 

 

16. Press OK  to apply your settings.  You may edit the settings of any existing master 
connections by selecting it and pressing the Edit  button.  Use the Delete button to 
remove a Modbus TCP connection. 

12.2 Reading Process Data Serially 
 To configure the SmartVue as a Modbus slave for serial communications 

1. Select MENU > Communications > Serial Settings > RS232 Settings.  Select 
RS485 Settings if you wish to use the RS485 interface. 

Set the Serial Mode control to one of MB Slave ASCII, MB Slave RTU, MB 
Master ASCII , or MB Master RTU  depending on the device role and the type of 
Modbus protocol being used on the network.  For this example, we want MB 
Slave RTU displaying the screen shown below. 

 
Figure 12-6  RS232 Settings with MB Slave RTU serial mode 
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(Note: selecting Off, shuts off the serial communications interface.  Selecting 
Stream sends data using SmartVue’s data streaming protocol and is described in 
Section 11.0) 

2. Set the Slave Address for the SmartVue between 1 and 247.  The value should 
not conflict with any other devices on the connected Modbus network. 

3. Set the Baud Rate to the desired value.  Options include: 600, 1200, 2400, 4800, 
9600, 14400, 19200, 38400, 57600, and 115200 bits per second. 

4. Set the Parity .  The options are Odd, Even, or None.  This should match the 
configuration of the master device. 

5. Set the Stop Bits to either 1 or 2.  This should match the configuration of the 
master device. 

6. Set how 32-bit wide data should be transmitted: high-order register first or low-
order register first.  This can be set separately for floats and integers. 

7. The Response Delay, if needed, can be used to set the amount of time to wait 
after the SmartVue receives a command and before it sends a response.  This may 
be required for communications paths that have a half-duplex part like RS485. 

8. Press OK  to apply your settings. 

 

 To select a Process data register to read using Modbus 

1. Select MENU > Communications > Modbus Regs & Diag > Process/Control 
Registers. 

2. Select a vacant Process/Control register address by tapping the area in the Data 
Point column, and then press Add.  Available Process/Control registers range 
from 201 to 263.  Use the arrow buttons to navigate the range of registers. 

3. On the selected Modbus Register screen, choose the Process or Control Process 
that you wish to provide a data point for.  (Only enabled processes will be 
available).  Next, choose the Data Point, which will either be a measured value or 
its status (the type of process or a potential error code). 

 

4. Press OK .  The selected process will be listed on the Modbus Process/Control 
Registers screen.  In this example, an RTD temperature sensor is connected, and 
Process 1 is configured to handle the input data. 



SmartVue Operator’s Manual 

82  10-0004-R13 

 

5. Press OK  to apply your changes.  In this case, the 32-bit floating point 
temperature data is now available for reading via Modbus from register 201. 

 
  



  SmartVue Operator’s Manual 

10-0004-R13  83 

12.3 Reading J1939 Data 
The SPN data, which can be either floating point or integer, can be accessed via Modbus 
over the Input Register range of 1003 to 1048.  The data is two bytes wide, thus the first 
data value is contained in registers 1003 to 1004, the second in registers 1006 to 1007, 
and so on. 

Modbus J1939 SPN Registers  
Function Code 3 or 4 - Read Only 

Offset Register Modicon Modicon Tag Status/Data  

1000 1001 31001 41001 J1939STATUS Status 

1001 1002 31002 41002 SPNSTATUS1 Status 

1002 1003 31003 41003 SPNDATA1 Data 

1004 1005 31005 41005 SPNSTATUS2 Status 

1005 1006 31006 41006 SPNDATA2 Data 

1007 1008 31008 41008 SPNSTATUS3 Status 

… … … … … … 

 
The status of each SPN data register is also available with the first SPN status register 
being 1002, the second, 1005, and so on.  The following table summarizes the meaning of 
each bit position if set. 

Bit Position  Description  
0 No Data 

1 Timeout 

2 Over Range 

3 Under Range 

4 Stack Not Running 

5 Data is Integer 

6 Disabled 

 
Register ID 1001 (address 1000) stores the status of the J1939 stack as an integer value. 

J1939 
Stack Status  Description  

0 Disabled 

1 Claiming 

2 Claim Failed 

3 Initialized 

4 Running 

5 Internal OS Error 

 
When monitoring selected SPN data, the register assignments can be examined using the 
View J1939 SPN Registers screen. 

 To view the J1939 SPN Register assignments 

• Select MENU > Communications > Modbus Regs & Diag > View J1939 SPN 
Registers. 
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Refer to Appendix 0 for the complete list of Modbus Input Registers that are available for 
reading SPN data. 

When reading the DTC data, up to 16 separate ECUs can be simultaneously monitored.  
With each ECU, access to its status, lamp state, and the number of codes that have been 
produced is available.  Up to 10 DTCs along with their related FMI (Fault Mode 
Identifier) and OC (Occurrence Count) information can be accessed for each ECU. 

The table below shows the registers and accompanying data for the first ECU followed 
by two sets of DTC data (four registers each).  Refer to Appendix 21.4.6 for a more 
complete table. 

Table 12-1  DTC Modbus register mapping 

 Address Register ID Modicon Modicon Data 
 1100 1101 31101 41101 STATUS1 

ECU1 
1101 1102 31102 41102 ECU1 
1102 1103 31103 41103 LAMP1 
1103 1104 31104 41104 NCODES1 

DTC1 

1104 1105 31105 41105 DTC1-1_H 
1105 1106 31106 41106 DTC1-1_L 
1106 1107 31107 41107 FMI1-1 
1107 1108 31108 41108 OC1-1 

DTC2 

1108 1109 31109 41109 DTC1-2_H 
1109 1110 31110 41110 DTC1-2_L 
1110 1111 31111 41111 FMI1-2 
1111 1112 31112 41112 OC1-2 

 … … … … … 

12.4 User Registers 
The SmartVue has a set of Modbus registers that can be written to during Modbus 
communication called user registers.  These are the only Modbus registers can be used as 
the inputs to a process or control.  There are 8 of each data type and there are 5 data 
types.  The data types are: 

16-bit unsigned integer 
16-bit signed integer 
32-bit unsigned integer 
32-bit signed integer 
32-bit float 

There is a separate screen for each data type and each screen displays the real-time 
current value and the number of seconds since the value was last updated.  The seconds 
since update can be used in a process or control to optionally use a different value if the 
updates have stopped.  Two of the User Register screens are shown below. 
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12.5 Communications Diagnostics 
The Comm Diagnostics screens can help during troubleshooting by showing you the 
status of Modbus master and slave connections.  It is found here: MENU > 
Communications > Modbus Regs & Diag > Comm. Diagnostics 

     

Master Connections 
Name – This is to identify the connection.  Either a TCP connection or a serial. 
Cmd – This is the Modbus Function number of the last polling command issued. 
PollRow – This is the row of polling table for the last command. 
ErrRow  – This is the row of polling table that resulted in an error. 
ErrCode – This is the error code from the last command that resulted in an error.  
Here are the possible error codes: 
 

Error code Meaning 

1 
Modbus exception code 1 returned by slave.  Slave does not 

support function code. 

2 
Modbus exception code 2 returned by slave.  Slave does not 

support address specified in the command. 

3 
Modbus exception code 3 returned by slave.  Slave does not 

support data value it received. 

4 to 11 
Other uncommon Modbus exception codes returned by the slave.  

Check device documentation for description of exception. 

28 Serial only.  Slave responded with a bad CRC. 

30 Timeout.  Slave did not respond within the timeout specified. 

31 
The cmd could not be constructed because the SmartVue 

from/source register does not exist. 

32 
The response could not be processed because the SmartVue 

to/destination register is not a user register. 
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ErrCnt  – This is a count of the number of commands issued that resulted in an 
error. 
CmdCnt – This is the total number of commands issued on the connection since 
power-up. 

 
Slave Connections 

Name – This is to identify the connection.  Either a TCP connection or a serial. 
MasterIP – This is the IP Address of the connected master. 
Cmd – This is the Modbus Function number of the last command received.  A 
“D:” preceding the function number means the connection is currently 
disconnected. 
ErrCmd  – This is the function number from the last command that resulted in an 
error. 
ErrCode – This is the error code from the last command that resulted in an error. 
 

Error code Meaning 

1 
Modbus exception code 1 was returned by SmartVue.  Master sent 

a function code that the SmartVue does not support. 

2 

Modbus exception code 2 was returned by SmartVue.  Master 

specified an address that the SmartVue does not support.  Trying 

to write to a read-only address also causes this exception. 

3 
Modbus exception code 3 was returned by SmartVue.  Master sent 

a bad values in the register count or data length fields. 

28 Received a command but has a bad CRC.  

 
ErrCnt  – This is a count of the number of commands received that resulted in an 
error. 
CmdCnt – This is the total number of commands received on the connection 
since power-up. 
Note – for Slave TCP connections the same Master may not always connect to the 
same connection.  It will connect to the first available. 

NOTE: If you are seeing the D: in the Cmd column but also seeing the cmdcnt 
increasing then you may have a situation where some commands are succeeding 
and some are failing and there are disconnections are reconnections happening at 
a very fast rate - faster than the diagnostics screen can show. 
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13.0 Updating the Firmware 
The SmartVue’s embedded firmware can be updated when new releases become 
available that expand or improve functionality.  Updates will be made available on 
Dycor’s website or can be e-mailed directly to the customer as needed.  Some updates 
will be provided freely while others may require a license. 

Updates are in the form of a SmartVue Application file ending with a .sva extension.  
Updating does not affect stored configuration settings. 

 To upload a new firmware version 

1. Press Menu > SmartVue > Upload Firmware.  This will display the message 
shown in the figure below. 

 

2. Copy the SmartVue application file to a USB flash drive and insert it into the 
USB port on the back of the unit, then press OK .  (Pressing Cancel will return 
you to the SmartVue menu without updating the unit.) The SmartVue Application 
Loader will begin and display the following message: 

 

3. The Application Loader will detect the .sva file and display a message similar to 
the one shown below. 
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Press OK  to proceed.  Pressing Cancel will reset the SmartVue without updating 
it.  The following screen will be displayed to indicate the progress of the firmware 
programming stages. 

 

Once updating is completed, the SmartVue will prompt you to touch the screen so 
it can initiate a reset.  During the reset you may see the message, “Uploading DSP 
firmware” at which time the digital signal processor firmware will also be 
updated. 

4. Remove the USB flash drive. 

 

Updating When Powering On 
If the unit if off, you can press and hold on the touch screen while the unit is 
powered on.  If a USB flash drive is not detected the touch screen calibration 
feature will start followed by the brightness adjustment screen for the LCD, you 
will then be prompted to insert a USB flash drive containing a file for the new 
firmware if you wish to update the firmware to a new version.  If the USB drive is 
already inserted the touch screen calibration and brightness adjustment steps will 
be skipped. 

 

Save Time Upgrading Multiple Units 
You can remove the USB flash drive after Stage 1 of 4 is completed.  This will 
help you save time if you are upgrading multiple SmartVue’s with a single flash 
drive. 
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14.0 Password Protection 
Several screens can be password protected to prevent important configuration settings 
from being changed indiscriminately.  For example, you may want to “lock” certain 
process configurations if they are measuring or controlling a critical task. 

When password protection is turned on, a small lock icon will appear in the upper right 
corner of the screen.  The icon will also indicate whether the unit is “locked”.  The icon 
appears unlocked if a user is logged in and locked when logged out. 

 

The following menu items are locked when password protection is turned on and a user is 
not logged in: 

• Main Menu 
o Processes 

 Locked process (user selectable) 
o Control Processes 

 Locked control processes (user selectable) 
o Configure I/O 
o Set Outputs 
o Communications 
o File System 

 Load Default Settings 
o SmartVue 

 Password 
 

 To turn on password protection 

1. Select MENU > SmartVue > Password. 

2. Enter the same password in the Password and Confirm  fields.  You can also 
reuse a previously stored password. 

• The password must be between 2 and 10 characters in length and contain 
only letters and numbers.  Spaces and symbol characters are not allowed. 

• If you are logged in, you can change the password. 

3. Press the spinner control to indicate On. 
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4. Press OK . 

The unit will be in an unlocked, or ‘logged in’ state, following the setup of 
password protection.  To lock the unit, you must log out by pressing the Logout 
button on the SmartVue menu screen. 

 

If password protection is turned on you can log into the SmartVue by entering the 
password.  An error message will be displayed if you try to log in and password 
protection is shut off. 

 To log into the SmartVue 

1. Select MENU > SmartVue > Login.  (The button will display the word “Logout” 
if you’re already logged in.) 

2. Enter the password. 

Press the button again to log out. 

 
Notes: 

• When you turn on password protection, don’t forget to use the Save Settings 
feature to save the password and on/off setting, otherwise if the unit is shut off it 
will not be password protected when you turn it back on. 

 
What if I forget my password? 
If you forget your password and you become locked out, you will have to upload 
a previous version of the firmware, use the Save Settings feature to overwrite the 
stored settings and then upload the current firmware again.  You will lose your 
previously stored settings which will revert to factory default values. 
 
Contact Dycor for a SmartVue Application file for a previous version if you do not 
have one. 
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15.0 File System 
The file system options allow you to store the SmartVue’s configuration settings either 
locally or on a USB flash drive.  A configuration file can be loaded again later to restore 
previous settings, or it can be loaded onto another SmartVue so that settings may be 
replicated from one unit to another. 

The file system options are available from the Main Menu.  The File System menu is 
shown below followed by a summary of what each button does. 

 
Figure 15-1  The File System menu 

The File System menu displays buttons for the following options: 

Load Default Settings loads the unit’s factory settings for all I/O points, processes, meters, 
and communications configurations.  If the default settings are loaded you must still press 
Save Settings to preserve them before powering off the SmartVue. 

Load Settings from USB allows you to load a settings file from a USB flash drive.  Once 
loaded, you must press Save Settings to keep the new settings.  Press Save Settings to 
preserve the newly loaded settings before powering off the SmartVue. 

Save Settings to USB lets you save the SmartVue’s current settings to a file on a USB 
flash drive.  File names are assigned a default value consisting of a number sequence 
indicating the current date and time (with the format YYMMDDhhmm), but you can also 
specify your own file name.  SmartVue configuration files are given the extension .svc. 

Save Settings saves the SmartVue’s current settings to internal memory. 

Reload Saved Settings  reloads the last saved settings saved to internal memory.  If 
changes are made to the settings and are not yet saved, you can quickly restore them 
using this option. 

Data Logging  displays the Data Logging menu.  Options for enabling logging and 
configuring the frequency, format and contents of logged processes, I/O, and J1939 data 
are provided. 
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Passwords are not saved within the settings file 
The password and the password protection setting are not saved as part of the 
settings file when saved to a USB flash drive, nor are existing password settings 
overwritten when a settings file is loaded. 

 

Loading a new configuration disables processes and outputs 
Loading new settings means new SmartVue processes and output settings could 
be loaded overtop of existing ones.  As a result, the new processes will not be 
automatically started.  This is to give you the opportunity to review the 
configuration for validity prior to running them since any connected devices, 
circuits or sensors could also be affected leading to undesirable and possible 
detrimental consequences. 

15.1 Saving and Loading SmartVue Settings 
 To save the SmartVue’s configuration to a USB flash drive 

1. Insert a USB flash drive into the USB port. 

2. Select Main Menu > File System > Save Settings. 

 

3. Use the File Name text control to specify a name for the configuration file or 
accept the default file name indicating the current date/timestamp (in the format 
YYMMDDhhmm). 

If you wish to overwrite an existing file, press the File List button to display the 
list of configuration files on the USB flash drive, select the file name of the file 
you wish to overwrite, and then press OK .  The selected file name will then 
appear in the File Name text control. 

     

4. Press OK  to save the configuration file. 
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5. Press OK . 

 

 To load a SmartVue configuration file from a USB flash drive 

1. Insert a USB flash drive into the USB port. 

2. Select Main Menu > File System > Load Settings.  This will display a File 
Select screen listing all .svc files on the flash drive along with the file size and a 
Date/Timestamp.  Press a file name to select it. 

 

3. Press OK .  When loading a configuration file, you have the option of preserving 
the current Ethernet and/or J1939 communications settings without overwriting 
them with the settings in the file.  Specify Yes if you wish to load the settings 
stored in the file you selected. 

 

4. Press OK .  A warning message is displayed to remind you that the newly loaded 
processes and outputs will be disabled until they are manually run. 
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5. Press OK . 

 

6. Press OK . 

7. The blue frame around the screen indicates that the newly loaded processes are 
not running and the outputs have been turned off.  In addition, each meter on the 
Meter screen will indicate this by displaying the message “DISABLED”. 

     

Once you are satisfied that the unit is physically connected and configured in a 
fashion that is suitable for your application, you can run the configured processes 
and engage the outputs by selecting Run on the Run / Stop screen, which is 
accessed from the Main Menu. 
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16.0 Data Logging 
When enabled, the SmartVue can log data to its internal flash memory from any of the 
following sources: 

• Processes 1-8 (selectable) 
• Control processes 1-2 (selectable) 
• Inputs/Outputs 
• J1939 SPN data 
• J1939 DTCs (selectable) 
• Modbus User Registers groups 1-5 (selectable) 

 
The data logging feature is accessed from the Main menu > File System. 

 
Figure 16-1  The Data Logging menu 

The Data Logging menu contains the following options: 

Data Logging Setup  displays configuration options for enabling logging and configuring 
the frequency, format and contents of logged processes, I/O, and J1939 data. 

Export Data Logs  allows you to copy one or more data logs to a USB flash drive. 

Data Logging Status  displays a screen that reports information about log file memory 
usage. 

Pause/Resume Data Logging  lets you pause or resume data logging activity. 

Export DTC Data Logs  allows you to copy one or more DTC data logs to a USB flash 
drive. 

DTC Data Logging Status  displays a screen that reports information about DTC log file 
memory usage. 

 
Data logging and power loss 
If power is shut off or lost while data logging is progress the SmartVue will automatically 
resume logging when power is restored.  The file that was being logged to will be 
preserved and a newly generated data file will continue with storing the data. 

Likewise, if the SmartVue’s date or time is adjusted while data logging is in progress, a 
new file will be created at that moment so that the time stamped data (and log file names 
that are named with a time stamp) accurately references the newly set time. 
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16.1 Data Logging Setup and Status 
The Data Logging Setting screen is used to enable data logging, set the data log file 
name, specify the logging period, what will be logged, and how data is stored to the 
internal flash memory. 

   

Figure 16-2  Data Logging Settings screen 

 To setup data logging 

1. Access the Data Logging Settings screen.  (Select MENU > File System > Data 
Logging > Data Logging Setup.) 

2. Set Logging to Enabled.  Set it to Disabled to discontinue data logging. 

3. The Filename (Prefix) spinner control can be set to either Time or Name.  The 
Time setting will cause file names to be prefixed with a timestamp value 
corresponding to its creation date and time with the format YYYYMMDDhhmm-
xxx.  If set to Name, you can supply your own custom prefix up to 12 characters in 
length.  A three digit numerical index will follow the name to differentiate 
between separately generated files.  DTC data logs will include a ‘D’ in the index 
part of the file name. 

Press Select Items to Log.  Select any of the items by tapping their respective 
names in the Item column.  A green checkmark symbol will appear next to each 
selected item.  Use the Select All or Deselect All buttons to save time choosing 
items.  Use the navigational arrow buttons to view additional items.  Press OK  
when you are finished selecting items. 

   

4. Likewise, you can press the J1939 DTCs button to select any active J1939 
devices so that related DTCs can be logged. 
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5. Specify whether or not you wish to limit the number of samples that will be 
recorded in each log file.  If the Limit File Size spinner is set to Yes you can 
specify a limit in the numeric Samples field.  The default value of 65,533 
samples, for example, would be compatible with older versions of spreadsheet 
software, allowing all of the data plus the header rows to be loaded.  If the setting 
is set to No, there will be no sample limit to individual log files. 

6. Optionally, you can configure additional settings to control how the data will be 
stored: 

Overwrite Data  If Yes is specified, then when the internal storage 
capacity has been reached during logging, older files 
will be overwritten with new data for the current data 
file.  If No is selected, data logging will cease when the 
storage capacity is reached. 

Overwrite DTC Data  If Yes is specified, then when the internal storage 
capacity has been reached during logging, older files 
will be overwritten with new data for the current DTC 
data file.  If No is selected, data logging will cease 
when the storage capacity is reached. 

Advanced  The Advanced Settings screen allows you to specify a 
maximum number of samples that will be logged.  
Logging stops when the maximum is reached. 

 

Additional information about available storage, sample 
size and the time left until capacity is reached is also 
given. 

When you press the Optimize button, the SmartVue 
will calculate the optimal size for each sample for only 
the selected data source items as opposed to a larger 
size that can handle all potential data sources.  This has 
the effect of increasing the available memory for logged 
data and, in turn, the number of samples that can be 
logged. 
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7. Press OK .  Data logging will now begin. 

If you have changed the Advanced Settings (the maximum number of samples 
setting) you will see the following warning: 

 

If you select Yes, the currently stored log files will be lost.  If you select No, the 
Advanced Settings will revert to their previous values and your data files will not 
be lost.  This warning can appear anytime a configuration is loaded and the 
number of samples is different. 

 
Changing Advanced Settings 
If you change the Advanced settings all of the data logs that are currently stored will 
be lost to accommodate the newly selected data storage structure.  You may want to 
export data logs to a USB flash drive before making changes to the Advanced 
Settings. 

 
Notes 

• Data log files are automatically appended with a .csv extension designating it as a 
comma separated values file.  .csv files can be directly opened by text editors and 
spreadsheet programs such as Microsoft Excel®. 

• For time stamped file names, you will only see the numerical index increment 
from 000 if a new data log file is generated within the same minute as the 
previous log file with the same timestamp. 

• One of the following icons will appear in the upper right corner of the display 
when data logging is enabled. 

Icon Description 

 Data logging is enabled 

 Data logging is paused 

 The data logging memory is full 

 The data logging memory is full and paused 

 

The data logging status screen provides information about the number of files stored, 
number of samples taken, and the amount of memory consumed.  The amount of time 



  SmartVue Operator’s Manual 

10-0004-R13  99 

remaining for data logging to continue with the current configuration setup (without 
overwriting old data) is also displayed. 

 To display the current data logging status 

Select MENU > File System > Data Logging > Data Logging Status. 

 
Figure 16-3  The Data Logging Status screen 

Note: the Estimated Logging Time Remaining will not be displayed if the Overwrite Data 
option is enabled. 

16.2 Exporting and Deleting Data Logs 
Internally stored data logs can be exported to a USB flash drive using the procedure 
below.  Data logs can also be deleted to free up storage space. 

 To export data logs to a USB flash drive 

1. Select MENU > File System > Data Logging > Export Data Logs.  (Select 
Export DTC Data Logs to copy DTC data to a USB flash drive.) 

2. In the File Name column select the data logs you wish to export.  Selected files 
will be highlighted green.  Additional log files may be listed on additional pages.  
All of the data logs can be quickly selected by pressing Select All. 

 

3. Press Export .  A warning screen will appear.  Note that data logging is paused 
during the export process.  Press OK  to continue. 

Additional navigational arrow buttons will 
appear once the number of file names 
exceeds a complete page. 
 
The single-arrow buttons advance forward 
or back one page at a time and will wrap 
around in the page count. 
 
The double-arrow buttons advance 10 
pages at a time or to the first/last pages if 
there are less than 10 pages. 
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4. Make sure a USB flash drive is inserted into the USB port on the back of the 
SmartVue and then click OK .  (A warning message will appear if one is not 
detected.) 

     

5. When the export is finished press OK  to return to the Data Log Export screen. 

 

It is possible to export a subset of Process, Control Process, and I/O data from a selected 
log file.  This is helpful when you have a large log file and want to save time exporting 
only the relevant data you need from a desired time range. 

 To export a subset of data from a log file 

1. Select MENU > File System > Data Logging > Export Data Logs. 

2. In the File Name column select a single data log file you wish to export a subset 
from. 

 

3. Press Export Subset.  A warning screen will appear.  Note that data logging is 
paused during the export process.  Press OK  to continue.   
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4. Using the Start and End, date and time fields, select the range for the data within 
the data log you wish to export. 

 

5. Click OK . 

     

6. When the export is finished press OK  to return to the Data Log Export screen. 

 

 To erase all data log files 

• On the Data Log Export screen press Erase All and then press OK . 
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All data logs will be deleted.  If data logging is enabled, a new data log file will be 
immediately created and logging will resume. 

16.3 Pausing Data Logging 
There will be times when you will want to modify physical I/O connections or make 
configuration changes.  This may also be a time when you want to pause data logging to 
avoid storing unneeded or ambiguous data while settings are being changed. 

To pause data logging, press the Pause Data Logging button on the Data Logging menu.  
Press it again to resume logging. 
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17.0 SmartVue Configuration 
This section discusses the display configuration settings and other informational screens. 

17.1 Display Brightness 
The brightness, and to a certain extent, the viewing angle of the LCD display, can be 
adjusted as desired between values of 0 and 100%. 

 
Figure 17-1   Brightness configuration screen 

 To adjust the display brightness 

1. Press MENU > SmartVue > Brightness. 

2. Press the left and right arrow buttons to decrease or increase the brightness value 
between 0 and 100%. 

3. Press OK . 

 

Brightness and High Temperature 
In high ambient temperatures the SmartVue will automatically limit the maximum 
brightness to a value lower than the user’s setting to prolong the life of the LCD's 
backlight.  When this occurs the message, "High Temperature! Brightness limited 
to x%" will be displayed on the Brightness configuration screen where x% is 
the temporary brightness limit. 
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17.2 Touch Screen Calibration 
If the touch screen does not respond appropriately to presses, or the alignment of touches 
does not match properly with buttons, then it may need to be calibrated.  Note that on 
occasion a button may need to be pressed more than once (for example, if it is touched 
too lightly), but this does not necessarily mean that the touch screen is out of calibration. 

 To calibrate the touch screen 

1. Press MENU > SmartVue > Calibrate Touchscreen.  This will display the 
screen shown in Figure 17-2. 

 
Figure 17-2   Touch Screen Calibration screen 

2. A small target icon will appear on the screen.  Press and hold it for the duration 
indicated by the progress indicator, then release; the target will disappear and 
reappear in another location.  Repeat this process for the two remaining targets. 

For a more precise calibration you should keep your finger still in the center of 
the target.  The small square in the upper right indicates the level of precision with 
a distribution of measured points.  Below, the image on the left shows poor 
precision, while the image on the right shows good precision.  If you’re 
unsatisfied with the displayed distribution of points simply release your finger 
before the progress indicator completes and start again. 

         

You will be returned to the SmartVue menu at the end of the procedure 
automatically. 
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17.3 Monitor Data 
The Monitor Data screen displays all of the inputs and outputs, their labels, measured 
signal values, and their corresponding scaled values in their specified engineering units 
set in the (default) Configure I/O setup.  This screen is useful if you want to monitor all 
I/O points at once, including ones that may not be assigned to a meter. 

 
Figure 17-3  The Monitor Data screen 

Select MENU > SmartVue > Monitor Data to display the Monitor Data screen. 

17.4 Date and Time 
The Date / Time configuration screen allows you to set the SmartVue’s real time clock.  
The time setting is used to display meaningful values on the horizontal time axis on a 
meter’s history graph and can be displayed in either a 12-hour (showing AM or PM) or 
24-hour mode. 

 To set the date and time 

1. Press MENU > SmartVue > Date / Time.  This will display the screen shown in 
Figure 17-4. 

 
Figure 17-4   Date / Time screen 

2. Press the numerical fields for each date and time value you wish to change. 

3. Select AM  or PM and the time display mode: 12 hr. or 24 hr. 

4. Press OK . 
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17.5 Information 
The Information screen displays the name and version of the firmware application, the 
boot loader version, and details that identify the SmartVue itself, such as the model, serial 
number, and manufacturing date.  An example of the Information screen is shown below. 

 
Figure 17-5  The Information screen 
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18.0 Self-Preservation 
The SmartVue is equipped with an internal heater that allows the LCD display to operate 
at lower temperatures than would otherwise be possible.  Once the internal temperature 
drops to a certain point the heater will automatically turn on so that the LCD display, and 
thus controllability of the unit, is maintained.  Thus, it is normal that the unit will draw 
more power in colder temperatures. 

Also, as noted in Section 17.1 Display Brightness, the SmartVue will automatically limit 
the maximum brightness to a value lower than the user’s setting to prolong the life of the 
LCD's backlight.  The message, "High Temperature! Brightness limited to x%" will be 
displayed on the Brightness configuration screen when this occurs.  x is the temporary 
brightness limit percentage. 
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19.0 Boot-up Options 
Several boot-up options are available to allow diagnostic operations or hardware 
configuration to be performed, such as memory testing and display or touch screen 
calibration prior to the firmware application being loaded. 

To access the Boot Menu, press and hold the touch screen when the initial splash screen 
is displayed just after the unit is turned on or restarted. 

 
Figure 19-1  The Boot Menu 

19.1 Testing the SmartVue’s Memory 
Two memory tests can be conducted to test the integrity of the SmartVue’s DRAM and 
Flash ROM memory.  Both tests write and then read back a series of bit patterns to the 
given integrated memory circuits. 

The DRAM Test takes about 16 seconds and will not affect the SmartVue in any way.  
The Flash ROM test, however, is invasive and will overwrite the application firmware.  
This test, which takes about 4.5 minutes, should not be conducted unless you have a copy 
of the firmware to reload onto the SmartVue on hand.  The All Memory Test simply 
performs both tests in succession. 

If either test fails the units should be returned for repair. 

 
Figure 19-2  The Flash ROM test will require that the application firmware be reloaded 
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The Flash ROM Test and All Memory Test Erase the Application Firmware 
The Flash ROM is where the application firmware resides, thus testing it results 
in the firmware being erased!  This test should only be conducted if the memory 
is suspected of being faulty and you have a copy of the firmware to reload onto 
the unit after a test that passes is performed. 

 

19.2 System Information 
The System Information screen displays specific information about the SmartVue 
including is boot loader version, serial and model numbers, manufacture date and MAC 
address. 

 
Figure 19-3  Boot loader System Information screen 

19.3 LCD Brightness 
The LCD brightness can be adjusted between 0 and 100%. 

 

 
Figure 19-4  Boot loader LCD Brightness adjustment screen 
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19.4 Touch Calibration 
If the touch screen is out of calibration, the SmartVue may not respond properly to 
touches.  If this is the case, you can calibrate the touch screen using the Touch 
Calibration option from the Boot Menu.  By touching a few target locations on the screen 
references are provided for calculating the touch locations anywhere on the screen. 

 
Figure 19-5  Boot loader Touch Calibration screen 

Touch Calibration When Touch Control is Lost 
The Touch Calibration screen will be entered automatically from the Boot Menu 
by pressing anywhere on the screen during boot up and waiting for the ten 
second countdown to complete.  This is useful if you have lost touch control of 
the SmartVue altogether. 

19.5 Load Application 
The Load Application option works the same as described in Section 11.0 Updating the 
Firmware. 

19.6 Color Bar 
The Color Bar screen provides a check that the LCD cable is properly connected to the 
display mother board.  If there are any breaks in the gradients of color then the unit 
should be returned for repair. 

 
Figure 19-6  Boot loader Color Bar screen 
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20.0 SmartVue Remote 
SmartVue Remote is a Java application that allows remote graphical access to a SmartVue 
on a TCP/IP network.  This is convenient if you have one or more SmartVues on a 
network that you wish to monitor or control without having to go to the unit(s) directly.  
Also, multiple SmartVues installed in different locations could be controlled from a 
central location.  

20.1 Requirements 
The following are needed to remotely connect to a SmartVue: 

• An Ethernet network to which the SmartVue is connected 
• Java 
• The SmartVue Remote Java application (JAR file with bundled lib folder) 

 
Java applications require that the Java Runtime Engine (JRE; or simply ‘Java’) be 
installed on the computer that will be connecting to the SmartVue.  Chances are you 
already have it installed, but if not it is freely available from the Java website at 
www.java.com/download/.  Once downloaded and executed the installer application will 
install Java with minimal user intervention. 

20.2 Setting Up a SmartVue for Remote Access 
Before a SmartVue can accept a connection for remote monitoring or control, it must be 
configured to allow the connection.  Also, the remote user can be granted one of two 
levels of access: viewing only or viewing with the addition of control. 

 To setup a SmartVue for remote access 

1. Select MENU > Communications > Ethernet Settings.  The Ethernet Settings 
screen will be displayed. 

2. The Ethernet settings must first be configured as described in Section 9.1.  An IP 
Address, Subnet Mask and Gateway must be set.  Note the values in the figure are 
merely examples.  You may need to consult your network administrator for values 
that will work with your network. 

 
Figure 20-1  The Ethernet Settings screen 

3. Press the Services button, then SV Remote to display the SV Remote screen 
shown below.  Turn on remote access by setting the SV Remote option to On. 
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Figure 20-2  The Ethernet Settings – SV Remote screen 

4. Set options. 

SV Remote Port  The default port for the SV Remote connection is 2642, 
which should suffice but it can be changed if needed. 

Allow Remote User to Lock Touchscreen 

If set to Yes, the user that is remotely connected can prevent 
the touchscreen from being used to control the SmartVue.  
This is useful if you want to configure the SmartVue at the 
same time someone else has local access and competition 
for control arises.  When the touchscreen is locked the 
symbol below will be displayed in the center of the screen 
for the local user. 

 

5. Specify a password for one or both of the strategies for remote access (at least one 
must be entered).  The remote user will be required to enter one of the passwords 
when attempting to connect to the SmartVue using the SmartVue Remote 
application. 

Control & View  Allows the remote user to not only see the screen of the 
SmartVue, but to control is as well using a mouse. 

View Only  Allows the remote user to view the screen of the SmartVue, 
but not control it. 

If the same password is chosen for both connection methods the connection will 
default to the Control & View  type. 

6. Press OK  to return to the Ethernet Settings screen. 

7. Press OK  to apply the changes. 
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When a remote connection has been established with the SmartVue a link icon will 
appear in the upper right corner of the screen.  If it has a red border that means the remote 
user has locked the touch screen. 

     

Figure 20-3  Link icons 

20.3 The SmartVue Remote Application 
The SmartVue (SV) Remote application is used to make the connection to a SmartVue 
that is configured to allow remote access, display its screen, and if permitted, allow for 
remote control of it. 

To run SV Remote, double click the file, SV_Remote_Java.jar. 

The application window is show below.  When you run the program you will see a “Not 
Connected” message in the display area, which is normal until you configure the program 
to connect to the remote SmartVue. 

 

 

 

Figure 20-4  The SmartVue Remote program window 

Menu Bar

Toolbar

Display Area 

Connect

Disconnect
Capture screen Zoom X1 

Zoom X2 

Enable/Disable Remote Touchscreen 

Status/error messages 
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20.3.1 SV Remote Settings 
You can save your settings to a file so that you won’t have to enter them each time you 
run the application.  Several settings files can be generated for various SmartVues that 
you may want to connect to. 

Connection and display settings are saved in a SmartVue Remote Settings (SRS) file. 

The application will automatically reload the last SRS file that was used when it is 
executed. 

 To configure SmartVue Remote 

1. Select File > Settings.  This will display the Settings dialog shown below. 

 

2. In the Address field, enter the IP address for the SmartVue you want to connect 
to.  The Port value should also match the port number entered in the SmartVue’s 
Ethernet configuration. 

3. In the Password field, enter the password for the type of connection you will 
make: Control & View  or View Only.  (It’s possible that only one may be set on 
the SmartVue.) 

4. The Capture Folder is where snapshot images of the screen will be saved when 
the capture icon is clicked.  Use the browse button to navigate to an appropriate 
location on your hard drive.  The default is “./” which means that the images will 
be saved in the same folder that the application is in. 

5. Options 

Disable SmartVue Touchscreen 

If checked, the connection to the remote SmartVue will 
initially begin with the unit’s touchscreen disabled. 

Screen Interpolation 

When checked, the display is rendered in such a way as to 
minimize pixilation when the application window is resized 
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above the normal x1 dimension.  This has the effect of 
making the rendered display look smoother. 

Auto Connect  With this option checked the program will automatically 
connect with the specified SmartVue when the application 
is executed without have to select File > Connect or click 
the Connect icon. 

6. Click OK . 

 
To save your settings file simply select File > Save Settings As…, enter an appropriate 
file name and click Save.  Choose File > Save Settings if the file has already been 
created if you make any changes you want to save. 

To load a settings file, select File > Load Settings…, browse for the desired SRS file, 
and click Open. 

20.3.2 Connecting/Disconnecting 
Once the settings have been configured for the SmartVue you are intending to connect to 
you can connect to it. 

Multiple instances of the SmartVue Remote application may be executed at the same time 
to connect to multiple SmartVues, but only one remote connection can be made to an 
individual SmartVue. 

To connect to a SmartVue, select File > Connect or click the Connect icon on the 
toolbar. 

Likewise, to disconnect from a SmartVue, select File > Disconnect or click the 
Disconnect icon on the toolbar. 

20.3.3 Displaying and Capturing Screen Images 
Click the Capture icon on the toolbar to take a snapshot of the screen and have it stored 
on your hard drive in the folder assigned with the Settings dialog.  Images are 320 x 240 
pixels in size (the same as the SmartVue’s LCD resolution) and are stored as PNG files 
less than 10 KB in size. 

The application window can be resized to display a larger version of the remote 
SmartVue’s screen by dragging any border or corner.  Two zoom options are available in 
the View menu and on the toolbar: X1 and X2 so that you can easily switch between the 
normal size and a double-sized display. 

The message area of the toolbar continuously displays the display refresh rate and size in 
bytes of the screen image as it is loaded. 
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Figure 20-5  SmartVue Remote displaying a remote screen 
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21.0 Appendix 

21.1 Mechanical Drawings 
This section contains dimensional drawings and panel cutout dimensions for mounting 
the SmartVue to a panel.   

Panel Mounting Kit: Phillips Pan Head screws with washers for panel mounting (for 
various panel thicknesses): 6-32 × 1/2" screws (4), 6-32 × 5/8" screws (4), 6-32 × 3/4" 
screws (4). 

 
Figure 21-1   Panel mounting cutout dimensions 

 
Figure 21-2   SmartVue dimensions 
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21.2 Panel Mounting the SmartVue 
The SmartVue is designed and manufactured to maintain a NEMA 4 compatible rating 
when properly installed into a NEMA 4 or higher rated enclosure.  Mounting is simple 
and requires only the supplied gasket and a #2 Philips screwdriver. 

 To install the SmartVue 

1. Prepare the installation location with the panel cutout.  Please refer to Figure 21-1 
for panel cutout dimensions.   

2. Ensure that the gasket is in place behind the bezel. 

3. Insert the SmartVue through the panel cutout, as shown in Figure 21-3. 

 
Figure 21-3   SmartVue installation – exploded view 

4. Secure the SmartVue using the supplied screws and washers, as shown in Figure 
21-4.  A mounting kit with three sets of different length screws is supplied for 
installation into panels of varying thickness. 

 
Figure 21-4   SmartVue installed in panel 

Gasket Mounting surface 
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21.3 Power and Signal Connections 
Power and input/output connections are made through four removable terminal blocks on 
the back of the SmartVue (Figure 21-5).  The terminal assignments are listed in Table 
21-1. 

 
Figure 21-5   Rear view of the SmartVue with terminal block layout 

Each terminal block can be removed without having to disconnect any wires that may 
already be secured to the terminals.  To remove a terminal block use a small slotted 
screwdriver to loosen the two screws on both ends, then pull the connector socket away 
from the terminal pins. 

Table 21-1   SmartVue Terminal Block Pinout 

Connector Terminal Label Description 

J1 

1 0-10V OUT 2 0-10 V output 2 (100Ω, 10 mA max.) 

2 0-10V OUT 1 0-10 V output 1 (100Ω, 10 mA max.) 

3 ISOLATED 24V - 24 V supply (negative) 

4 ISOLATED 24V + 24 V supply (positive) 

5 4-20mA OUT 2- 14-bit analog isolated output 2 (negative) 

6 4-20mA OUT 2+ 14-bit analog isolated output 2 (positive) 

7 4-20mA OUT 1- 14-bit analog isolated output 1 (negative) 

8 4-20mA OUT 1+ 14-bit analog isolated output 1 (positive) 

9 4-20mA IN 2- 16-bit analog input 2 (negative) 

10 4-20mA IN 2+ 16-bit analog input 2 (positive) 

11 4-20mA IN 1- 16-bit analog input 1 (negative) 

12 4-20mA IN 1+ 16-bit analog input 1 (positive) 
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Connector Terminal Label Description 

J2 

13 RTD SNS / TH* / TC+* 
RTD sense, thermistor, thermocouple 
(positive) 

14 RTD EXC RTD excitation 

15 RTD GND / TH* / TC-* 
RTD ground, thermistor , thermocouple 
(negative) 

16 DIO6 / VIN 6 Digital input/output 6, Analog input 6 

17 DIO5 / VIN 5 Digital input/output 5, Analog input 5 

18 DIO4 / VIN 4 Digital input/output 4, Analog input 4 

19 DIO3 / VIN 3 Digital input/output 3, Analog input 3 

20 DIO2 / VIN 2 Digital input/output 2, Analog input 2 

21 DIO1 / VIN 1 Digital input/output 1, Analog input 1 

22 GND Ground 

23 FRQ OUT 2 Frequency output 2 

24 FRQ OUT 1 Frequency output 1 

J3 

25 TACH IN 2 Tachometer input 2 

26 TACH IN 1 Tachometer input 1 

27 GND Ground 

28 QENC2-A / CTR1 
Quadrature counter 2 input A, Hardware 
counter 1 

29 QENC2-B / CTR2 Quadrature counter 2 input B, Hardware 
counter 2 

30 QENC1-A / CTR3 
Quadrature counter 1 input A, Hardware 
counter 3 

31 QENC1-B Quadrature counter 1 input B 

32 GND Ground 

33 RS232-RX RS-232 receive 

34 RS232-TX RS-232 transmit 

35 RS485 - RS-485 inverting 

36 RS485 + RS-485 non-inverting 
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Connector Terminal Label Description 

J4 

1 10..30 VDC INPUT DC Voltage In: Positive (10 to 30 VDC) 

2 PWR GND DC Voltage In: Ground 

3 EARTH Earth/chassis ground 

4 GND Ground 

5* CAN-H CAN-bus dominant high 

6* CAN-L CAN-bus dominant low 
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21.4 Modbus Register Mapping 
The tables below show the registers available using the Modbus protocol.  There are 
different ways to address the registers: Offset, Register and Modicon.  The SmartVue 
config screens use the Register column.  Modicon may have two addresses for the same 
register. 

21.4.1 Discrete I/O (Function Code 2 - Read Only bi t) 
 

Modbus Discrete I/O Registers (Fixed 
Mapping)  

Function Code 2 - Read Only bit 

Offset Register Modicon Name 

0 1 10001 Digital Input Valid 

1 2 10002 Digital Input Valid 

2 3 10003 Digital Input Valid 

3 4 10004 Digital Input Valid 

4 5 10005 Digital Input Valid 

5 6 10006 Digital Input Valid 

   Unused 

   Unused 

8 9 10009 Digital Output Valid 

9 10 10010 Digital Output Valid 

10 11 10011 Digital Output Valid 

11 12 10012 Digital Output Valid 

12 13 10013 Digital Output Valid 

13 14 10014 Digital Output Valid 

   Unused 

   Unused 

16 17 10017 Digital Input 

17 18 10018 Digital Input 

18 19 10019 Digital Input 

19 20 10020 Digital Input 

20 21 10021 Digital Input 

21 22 10022 Digital Input 

   Unused 

   Unused 

24 25 10025 Digital Output 

25 26 10026 Digital Output 

26 27 10027 Digital Output 

27 28 10028 Digital Output 

28 29 10029 Digital Output 

29 30 10030 Digital Output 
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21.4.2 I/O Registers (Function Code 3 or 4 – Read O nly) 
 

Modbus I/O Registers (Fixed Mapping) 
Function Code 3 or 4 - Read Only 

Offset Register Modicon Modicon Name Data Type Unit s 

0 1 30001 40001 Serial Number 16-bit Integer  

1 2 30002 40002 Serial Number 16-bit Integer  

2 3 30003 40003 Year 16-bit Integer  

3 4 30004 40004 Month 16-bit Integer  

4 5 30005 40005 Day 16-bit Integer  

5 6 30006 40006 Hours 16-bit Integer  

6 7 30007 40007 Minutes 16-bit Integer  

7 8 30008 40008 Seconds 16-bit Integer  

8 9 30009 40009 Day of Week 16-bit Integer  

9 10 30010 40010 Monitor Data Input Mask HW 32-bit Integer bits 

11 12 30012 40012 Monitor Data Output Mask 16-bit Integer bits 

12 13 30013 40013 Temperature Sensor Status 16-bit Integer  

13 14 30014 40014 Temperature 32-bit Float °C 

15 16 30016 40016 Tachometer Rate 1 
32-bit Signed 

Integer Hz 

17 18 30018 40018 Tachometer Rate 2 32-bit Signed 
Integer Hz 

19 20 30020 40020 Counter Rate 1 
32-bit Signed 

Integer Hz 

21 22 30022 40022 Counter Rate 2 32-bit Signed 
Integer Hz 

23 24 30024 40024 Counter Rate 3 
32-bit Signed 

Integer Hz 

25 26 30026 40026 Quadrature Rate 1 32-bit Signed 
Integer Hz 

27 28 30028 40028 Quadrature Rate 2 
32-bit Signed 

Integer Hz 

29 30 30030 40030 Current Loop In 1 32-bit Float mA 

31 32 30032 40032 Current Loop In 2 32-bit Float mA 

33 34 30034 40034 Voltage In 1 32-bit Float V 

35 36 30036 40036 Voltage In 2 32-bit Float V 

37 38 30038 40038 Voltage In 3 32-bit Float V 

39 40 30040 40040 Voltage In 4 32-bit Float V 

41 42 30042 40042 Voltage In 5 32-bit Float V 

43 44 30044 40044 Voltage In 6 32-bit Float V 

45 46 30046 40046 Digital Inputs 1-6 16-bit Integer bits 

46 47 30047 40047 Current Loop Out 1 32-bit Float mA 

48 49 30049 40049 Current Loop Out 2 32-bit Float mA 

50 51 30051 40051 Voltage Out 1 32-bit Float V 

52 53 30053 40053 Voltage Out 2 32-bit Float V 

54 55 30055 40055 Frequency Out 1 32-bit Float Hz 

56 57 30057 40057 Frequency Out 2 32-bit Float Hz 

58 59 30059 40059 Digital Outputs 1-6 16-bit Integer bits 
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Modbus I/O Registers (Fixed Mapping) 
Function Code 3 or 4 - Read Only 

59 60 30060 40060 Scaled Temperature Float User Specified 

61 62 30062 40062 Scaled Tachometer Rate 1 Float User Specified 

63 64 30064 40064 Scaled Tachometer Rate 2 Float User Specified 

65 66 30066 40066 Scaled Counter Rate 1 Float User Specified 

67 68 30068 40068 Scaled Counter Rate 2 Float User Specified 

69 70 30070 40070 Scaled Counter Rate 3 Float User Specified 

71 72 30072 40072 Scaled Quadrature Rate 1 Float User Specified 

73 74 30074 40074 Scaled Quadrature Rate 2 Float User Specified 

75 76 30076 40076 Scaled Current Loop In 1 Float User Specified 

77 78 30078 40078 Scaled Current Loop In 2 Float User Specified 

79 80 30080 40080 Scaled Voltage In 1 Float User Specified 

81 82 30082 40082 Scaled Voltage In 2 Float User Specified 

83 84 30084 40084 Scaled Voltage In 3 Float User Specified 

85 86 30086 40086 Scaled Voltage In 4 Float User Specified 

87 88 30088 40088 Scaled Voltage In 5 Float User Specified 

89 90 30090 40090 Scaled Voltage In 6 Float User Specified 

91 92 30092 40092 Scaled Current Loop Out 1 Float User Specified 

93 94 30094 40094 Scaled Current Loop Out 2 Float User Specified 

95 96 30096 40096 Scaled Voltage Out 1 Float User Specified 

97 98 30098 40098 Scaled Voltage Out 2 Float User Specified 

99 100 30100 40100 Scaled Frequency Out 1 Float User Specified 

101 102 30102 40102 Scaled Frequency Out 2 Float User Specified 
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21.4.3 Process/Control Registers (Function Code 3 o r 4) 
 

Modbus Process/Control Registers (User Configurable  Mapping) 
Function Code 3 or 4 - Read Only 

Offset Register Modicon Modicon Process/Control (Us er) Variable (User) Reg Type (Auto) 

200 201 30201 40201 Process 1 (Pump Ctrl) 1 - Rate (RPM) 32 Float 

202 203 30203 40203 Process 2 1 - DIN 32 Integer 

204 205 30205 40205 Process 3 1 - SPN 
State(Gear) 

32 Integer 

206 207 30207 40207 Process 1 (Pump Ctrl) 
2 - Total 

(Rotations) 32 Float 

208 209 30209 40209 Control 1 (Flow) 2- Feedback 
(Flow) 

32 Float 

210 211 30211 40211 Process Status   

212 213 30213 40213 Control Status   

214 215 30215 40215 Control Multiplier   

216 217 30217 40217    

218 219 30219 40219  Process Status  

220 221 30221 40221  Process Type + Process Error 

222 223 30223 40223  0x10 Process Error (Input 
Error) 

224 225 30225 40225  0x0F Process Type Field 

226 227 30227 40227    

228 229 30229 40229  Control Status  

230 231 30231 40231  Control Type + Control Error + SP Error + 
FB Error  

232 233 30233 40233  0x40 FB Input Error 

234 235 30235 40235  0x20 SP Input Error 

236 237 30237 40237  0x10 
Control Error (Control 

Loop Stopped) 

238 239 30239 40239  0x0F Control Type Field 

240 241 30241 40241    

242 243 30243 40243    

244 245 30245 40245    

246 247 30247 40247    

248 249 30249 40249    

250 251 30251 40251    

252 253 30253 40253    

254 255 30255 40255    

256 257 30257 40257    

258 259 30259 40259    

260 261 30261 40261    

262 263 30263 40263    

Note: Process Type: 0 = Off, 1 = Standard, 17 = Input Error/Timeout.  See the Streamed Data Output section for 
more information on process type and control type fields. 
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21.4.4 User Registers (Function Code 3, 4, 6 or 16 - Read or Write) 
 

Modbus User Registers  
Function Code 3, 4, 6 or 16 - Read or Write  

Offset Register Modicon Modicon Data Type 
400 401 30401 40401 16-bit Unsigned Integer 
401 402 30402 40402 16-bit Unsigned Integer 

402 403 30403 40403 16-bit Unsigned Integer 

403 404 30404 40404 16-bit Unsigned Integer 

404 405 30405 40405 16-bit Unsigned Integer 
405 406 30406 40406 16-bit Unsigned Integer 

406 407 30407 40407 16-bit Unsigned Integer 

407 408 30408 40408 16-bit Unsigned Integer 

408 409 30409 40409 16-bit Signed Integer 

409 410 30410 40410 16-bit Signed Integer 

410 411 30411 40411 16-bit Signed Integer 

411 412 30412 40412 16-bit Signed Integer 

412 413 30413 40413 16-bit Signed Integer 

413 414 30414 40414 16-bit Signed Integer 

414 415 30415 40415 16-bit Signed Integer 

415 416 30416 40416 16-bit Signed Integer 

416 417 30417 40417 32-bit Unsigned Integer 
418 419 30419 40419 32-bit Unsigned Integer 

420 421 30421 40421 32-bit Unsigned Integer 

422 423 30423 40423 32-bit Unsigned Integer 

424 425 30425 40425 32-bit Unsigned Integer 
426 427 30427 40427 32-bit Unsigned Integer 

428 429 30429 40429 32-bit Unsigned Integer 

430 431 30431 40431 32-bit Unsigned Integer 

432 433 30433 40433 32-bit Signed Integer 

434 435 30435 40435 32-bit Signed Integer 

436 437 30437 40437 32-bit Signed Integer 

438 439 30439 40439 32-bit Signed Integer 

440 441 30441 40441 32-bit Signed Integer 

442 443 30443 40443 32-bit Signed Integer 

444 445 30445 40445 32-bit Signed Integer 

446 447 30447 40447 32-bit Signed Integer 

448 449 30449 40449 32-bit Float 
450 451 30451 40451 32-bit Float 
452 453 30453 40453 32-bit Float 
454 455 30455 40455 32-bit Float 
456 457 30457 40457 32-bit Float 
458 459 30459 40459 32-bit Float 
460 461 30461 40461 32-bit Float 
462 463 30463 40463 32-bit Float 
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21.4.5 J1939 SPN Registers (Function Code 3 or 4 - Read Only) 
 

Modbus J1939 SPN Registers  
Function Code 3 or 4 - Read Only 

Offset Register Modicon Modicon Tag Status/Data 

1000 1001 31001 41001 J1939STATUS Status 

1001 1002 31002 41002 SPNSTATUS1 Status 

1002 1003 31003 41003 SPNDATA1 Data 

1004 1005 31005 41005 SPNSTATUS2 Status 

1005 1006 31006 41006 SPNDATA2 Data 

1007 1008 31008 41008 SPNSTATUS3 Status 

1008 1009 31009 41009 SPNDATA3 Data 

1010 1011 31011 41011 SPNSTATUS4 Status 

1011 1012 31012 41012 SPNDATA4 Data 

1013 1014 31014 41014 SPNSTATUS5 Status 

1014 1015 31015 41015 SPNDATA5 Data 

1016 1017 31017 41017 SPNSTATUS6 Status 

1017 1018 31018 41018 SPNDATA6 Data 

1019 1020 31020 41020 SPNSTATUS7 Status 

1020 1021 31021 41021 SPNDATA7 Data 

1022 1023 31023 41023 SPNSTATUS8 Status 

1023 1024 31024 41024 SPNDATA8 Data 

1025 1026 31026 41026 SPNSTATUS9 Status 

1026 1027 31027 41027 SPNDATA9 Data 

1028 1029 31029 41029 SPNSTATUS10 Status 

1029 1030 31030 41030 SPNDATA10 Data 

1031 1032 31032 41032 SPNSTATUS11 Status 

1032 1033 31033 41033 SPNDATA11 Data 

1034 1035 31035 41035 SPNSTATUS12 Status 

1035 1036 31036 41036 SPNDATA12 Data 

1037 1038 31038 41038 SPNSTATUS13 Status 

1038 1039 31039 41039 SPNDATA13 Data 

1040 1041 31041 41041 SPNSTATUS14 Status 

1041 1042 31042 41042 SPNDATA14 Data 

1043 1044 31044 41044 SPNSTATUS15 Status 

1044 1045 31045 41045 SPNDATA15 Data 

1046 1047 31047 41047 SPNSTATUS16 Status 

1047 1048 31048 41048 SPNDATA16 Data 

Notes 
• J1939 Stack Status: 0=disabled, 1=claiming, 2=claim_failed, 3=initialized, 4=running, 5=internal_OS_error 
• SPN Status: bit0=nodata, bit1=timeout, bit2=over_range, bit3=under_range, bit4=stack_not_running, 

bit5=data_is_integer, bit6=disabled 
• Data can be float or integer 
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21.4.6 J1939 DTC Input Register (Function Code 3 or  4 - Read Only 16-bit) 
 

Modbus J1939 DTC Registers  
Function Code 3 or 4 - Read Only 16-bit  

Offset Register Modicon Modicon Data 
1100 1101 31101 41101 STATUS1 
1101 1102 31102 41102 ECU1 
1102 1103 31103 41103 LAMP1 
1103 1104 31104 41104 NCODES1 
1104 1105 31105 41105 DTC1-1_H 
1105 1106 31106 41106 DTC1-1_L 
1106 1107 31107 41107 FMI1-1 
1107 1108 31108 41108 OC1-1 
1108 1109 31109 41109 DTC1-2_H 
1109 1110 31110 41110 DTC1-2_L 
1110 1111 31111 41111 FMI1-2 
1111 1112 31112 41112 OC1-2 

  … … … 
1140 1141 31141 41141 DTC1-10_H 
1141 1142 31142 41142 DTC1-10_L 
1142 1143 31143 41143 FMI1-10 
1143 1144 31144 41144 OC1-10 

  … … … 
1144 1145 31145 41145 STATUS2 
1145 1146 31146 41146 ECU2 
1146 1147 31147 41147 LAMP2 
1147 1148 31148 41148 NCODES2 
1148 1149 31149 41149 DTC2-1_H 
1149 1150 31150 41150 DTC2-1_H 
1150 1151 31151 41151 FMI2-1 
1151 1152 31152 41152 OC2-1 
1152 1153 31153 41153 DTC2-2_H 
1153 1154 31154 41154 DTC2-2_L 

  … … … 
1760 1761 31761 41761 STATUS16 
1761 1762 31762 41762 ECU16 
1762 1763 31763 41763 NCODES16 
1763 1764 31764 41764 DTC16-1_H 
1764 1765 31765 41765 DTC16-1_L 
1765 1766 31766 41766 FMI16-1 
1766 1767 31767 41767 OC16-1 
1767 1768 31768 41768 DTC16-2_H 

  … … … 
1803 1804 31804 41804 OC16-10 

Notes 
• ECU STATUS: bit0=timeout, bit1=invalid, bit2=stack_not_running, bit3=disabled 
• LAMP: Indicator Lamps 

bit1: 0=Protect Lamp Status (SPN 987) 
bit3: 2=Warning Lamp Status (SPN 624) 
bit5: 4=Stop Lamp Status (SPN 623) 
bit7: 6=MIL Status (SPN 1213) 
bit9: 8=Flash Protect Lamp (SPN 3041) 
bit11: 10=Flash Warning Lamp (SPN  3040) 
bit13: 12=Flash Stop Lamp (SPN 3039) 
bit15: 14=Flash MIL  (SPN 3038) 
 


